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UNITED STATES

NoteNote

This equipment has been tested and found to comply with the limits for a Class A 
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference when the equipment is 
operated in a commercial environment. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the 
instruction manual, may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause harmful 
interference in which case the user will be required to correct the interference at his 
own expense.

Changes or modifications not expressly approved by the party responsible for compliance 
could void the user’s authority to operate the equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two 
conditions: (1) This device may not cause harmful interference and, (2) this device must 
accept any interference received, including interference that may cause undesired operation.

CANADA

Canada ICES-003:

CAN ICES-3 (A)/NMB-3(A)

MEXICO

IFETEL notice: La operación de este equipo está sujeta a las siguientes dos condiciones: (1) es 
posible que este equipo o dispositivo no cause interferencia perjudicial y (2) este equipo o 
dispositivo debe aceptar cualquier interferencia, incluyendo la que pueda causar su operación 
no deseada.
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EUROPE

WARNINGWARNINGWARNING

This is a Class A product. In a domestic environment, this product may cause radio 
interference in which case the user may be required to take adequate measures.

Waste Electrical and Electronic Equipment Directive

In accordance with the European WEEE Directive, this device needs to 
be recycled in accordance with local regulations.

RoHS Directive 2011/65/EU 

This product is CE marked and complies with the European Union's Directive 2011/65/EU OF 
THE EUROPEAN PARLIAMENT AND OF THE COUNCIL of 8 June 2011 on the 
restriction of the use of certain hazardous substances in electrical and electronic equipment.

Turkey

Turkish Ministry of Environment and Forestry

(Directive on the Restriction of the use of certain hazardous substances in electrical and 
electronic equipment).

Türkiye Cumhuriyeti: EEE Yönetmeliğine Uygundur
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Batteries Directive 2006/66/EC 

This product contains a lithium coin cell battery. The crossed-out wheeled 
bin shown to the left is used to indicate 'separate collection' for all batteries 
and accumulators in accordance with European Directive 2006/66/EC.   
Users of batteries must not dispose of batteries as unsorted municipal 
waste. This Directive determines the framework for the return and 
recycling of used batteries and accumulators that are to be collected 
separately and recycled at end of life. Please dispose of the battery 
according to your local regulations.

Notice to Recyclers

To remove the lithium coin cell battery: 

1. Disassemble printer and locate the lithium coin cell battery located on the main circuit 
board.

2. Using a small screwdriver, pry the battery from its holder and remove the battery from the 
board. Dispose of in accordance with local regulations.

To remove the NiMH battery pack:

1. Turn the printer over, open the battery compartment door, and remove the NiMH battery 
pack. 

2. Dispose of the pack in accordance with local regulations.
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Wireless Regulatory Information

Regulatory markings, subject to country certification, are applied to host printer signifying 
WiFi (radio) approvals have been obtained. These countries include; U.S., Canada, Mexico, 
European Union, Brazil, Australia, New Zealand, South Africa, China, Hong Kong, Japan, 
South Korea, Singapore.

 Operation of the device without regulatory approval is illegal.

WiFi radio module (permanently installed in printer)

United States

NoteNote

This equipment has been tested and found to comply with the limits for a Class A 
digital device, pursuant to part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference when the equipment is 
operated in a commercial environment. This equipment generates, uses, and can 
radiate radio frequency energy and, if not installed and used in accordance with the 
instruction manual, may cause harmful interference to radio communications.

Operation of this equipment in a residential area is likely to cause harmful interference in 
which case the user will be required to correct the interference at own expense.

Changes or modifications not expressly approved by the party responsible for compliance 
could void the user’s authority to operate the equipment.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two 
conditions: (1) This device may not cause harmful interference and, (2) this device must 
accept any interference received, including interference that may cause undesired operation.

Radio protocol WLAN  IEEE 802.11b/g/n

RF Operating Frequency 2.4 – 2.495 GHz

RF Output Power < +20dBm EIRP (100mW)

Antenna Type \  Antenna Gain PCB trace antenna \ -3.06 dBi

Environmental Operation -40 to 85° C  (-40° to 185° F)

Note: Be mindful of Brady host printer 
user guide for maximum operating 

Environmental Storage -55 to 125° C  (-67° to 257° F)

Note: Be mindful of Brady host printer 
user guide for maximum storage 
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Co-located statements: To comply with FCC RF exposure compliance requirement, the 
antenna used for this transmitter must not be co-located or operating in conjunction with any 
other transmitter/antenna except those already with radio module filing.

RF exposure guidelines: The radiated output power of this device is far below the radio 
frequency exposure limits. Nevertheless, to avoid the possibility of exceeding radio frequency 
exposure limits for an uncontrolled environment, a minimum 20cm distance should be 
maintained from WiFi radio module PCB antenna (internal) to the head, neck, or body during 
normal operation.

Canada

Industry Canada ICES-003: 

CAN ICES-3 (A)/NMB-3(A)

This device complies with Industry Canada’s licence-exempt RSSs. Operation is subject to the 
following two conditions:

1. This device may not cause interference; and

2. This device must accept any interference, including interference that may cause undesired 
operation of the device.

Co-located statements: To comply with FCC RF exposure compliance requirement, the 
antenna used for this transmitter must not be co-located or operating in conjunction with any 
other transmitter/antenna except those already with radio module filing.

RF exposure guidelines / Important note: This equipment complies with IC radiation 
exposure limits set forth for an uncontrolled environment. This equipment should be installed 
and operated with minimum distance 20cm between the radiator and your body.

Note Importante: Déclaration d'exposition aux radiations: Cet équipement est conforme aux 
limites d'exposition aux rayonnements IC établies pour un environnement non contrôlé. Cet 
équipement doit être installé et utilisé avec un minimum de 20cm de distance entre la source 
de rayonnement et votre corps.

Mexico

IFETEL notice: 

“La operación de este equipo está sujeta a las siguientes dos condiciones: (1) es posible que 
este equipo o dispositivo no cause interferencia perjudicial y (2) este equipo o dispositivo debe 
aceptar cualquier interferencia, incluyendo la que pueda causar su operación no deseada.”



Brazil

ANATEL notice: 

Este equipamento opera em caráter secundário, isto é, não tem direito a proteção contra 
interferência prejudicial, mesmo de estações do mesmo tipo, e não pode causar interferência a 
sistemas operando em caráter primário.

Este produto contém a placa model GS2011MIPS, código de homologação ANATEL 4208-
15-3693.

European Union

This is a Class A product. In a domestic environment, this product may cause radio 
interference in which case the user may be required to take adequate measures. 

Radio Equipment Directive (RED) 2014/53/EC 

(a) Frequency band(s) in which the radio equipment operates; 2.401GHz to 2.483GHz

(b) Maximum radio-frequency power transmitted in the frequency band(s) in which the radio 
equipment operate; < +20dBm EIRP (100mW)

International

The WiFi radio module used in Brady host printers comply with internationally recognized 
standards covering human exposure to electromagnetic fields, i.e. 

EN 62311 “Assessment of electronic and electrical equipment related to human exposure 
restrictions for electromagnetic fields (0 Hz - 300 GHz)”.

Japan

MIC \ TELEC: 006-000263

当該機器には電波法に基づく、技術基準適合証明等を受けた特定無線設備を装着し
ている。
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BRADY Warranty

Our products are sold with the understanding that the buyer will test them in actual use and 
determine for him or herself their adaptability to his/her intended uses. BRADY warrants to 
the buyer that its products are free from defects in material and workmanship, but limits its 
obligation under this warranty to replacement of the product shown to BRADY’s satisfaction 
to have been defective at the time BRADY sold it. This warranty does not extend to any 
persons obtaining the product from the buyer.

THIS WARRANTY IS IN LIEU OF ANY OTHER WARRANTY, EXPRESSED OR 
IMPLIED INCLUDING, BUT NOT LIMITED TO ANY IMPLIED WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, AND OF ANY 
OTHER OBLIGATIONS OR LIABILITY ON BRADY’S PART. UNDER NO 
CIRCUMSTANCES WILL BRADY BE LIABLE FOR ANY LOSS, DAMAGE, EXPENSE 
OR CONSEQUENTIAL DAMAGES OF ANY KIND ARISING IN CONNECTION WITH 
THE USE, OR INABILITY TO USE, BRADY’S PRODUCTS.

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS & CONDITIONS OF 
THIS LICENSE AGREEMENT. IF YOU DO NOT AGREE WITH THESE TERMS & 
CONDITIONS, PLEASE PROMPTLY RETURN THIS PACKAGE FOR A FULL REFUND.
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Technical Support

Technical Support Numbers/On-line Help

For repair or technical assistance, find your regional Brady Tech Support office in the 
following list.

• United States: 1-800-643-8766 or via the web at www.bradyid.com/techsupport

• Australia: 1-800 644 834 or via the web at www.bradyid.com.au/en-au/supportlanding

• Canada: 1-888-262-7576 or via the web at www.bradycanada.ca

• Mexico & Latin America: 01-800-212-8181 or via the web at  
www.bradylatinamerica.com

• Europe: +44 333 333 1111 or via the web at www.bradyeurope.com/services

Repair and Replacement Parts

Brady Corporation offers repair and replacement services. Contact Brady Technical Support 
for repair and replacement information.
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Description
1 Introduction

Description

The BMP®61 Label Printer is capable of printing on a variety of both die-cut and 
continuous supplies. It includes the following features: 

• Targeted applications to simplify the creation of specific label types 

• Battery operation - printing 1000 or more standard Brady labels with a fully charged 
Brady battery pack.

• Ability to use the printer while the BMP41-BATT NiMH battery pack is charging

• Color touch screen display

• Easy to use user interface

• USB 2.0 and USB flash drive

• One step media installation

• Smart-cell technology that works intelligently with Brady consumables

• Wireless connectivity (optional factory installed)

• Able to transfer files from PC or other external device
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Unpack Your Printer
Unpack Your Printer

The following items are included 

in the standard BMP®61 
package:

• BMP®61 Label Printer

• Hard-sided carrying case 
(BMP-HC-1)

• BMP41-BATT NiMH Battery 
Pack 

• AC adapter (US or Europe) 
and power cord 

• USB cable (BMP41-USB) 

• One M61-R6010 ribbon

• One PTL-19-423 general 
purpose white polyester media 
(1" x 25.4 mm x 25.4 mm)

• Product CD with user’s manual and Quick Start guide in various languages

• Brady Printer Drivers CD

• Printed Quick Start Guide

• Strap (BMP-Strap-1)

Accessories

The following items are accessories available for the BMP®61 Label Printer and 
can be purchased separately from your distributor:

• Magnet (BMP-MAGNET-1)

• Quick Charger (BMP-41-QC)

• Cleaning Kit
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Unpack Your Printer
Save Your Packaging

The packaging surrounding your BMP®61 printer should be saved in the event 
you have to ship the printer and accessories back to the supplier.

Do NOT remove the BMP41-BATT NiMH battery pack from the printer 

when shipping the BMP®61 printer and battery together.

If shipping the printer or the battery pack separately, place the item in 
the original shipping material before transporting. Batteries must be 
shipped according to state, federal, or municipal regulations. Consult 
your courier before shipping NiMH battery packs.

Register Your Printer

Register your printer on-line at www.bradycorp.com/register and receive free 
product support and updates!
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BMP®61 System Specifications
BMP®61 System Specifications

The BMP®61 printer has the following specifications:

• Weight 3.55  lbs (1.6 kg) (with battery pack and materials)

• Thermal Transfer Print Mechanism 300 dpi

• Optical Registration System for Precise Print Registration

• Elastomeric Keypad

• Custom True Type Fonts 

• Print Width - 2.0  inches (51 mm) maximum label width 

• Maximum print length for labels: 40” (990.6 mm)

• Prints up to 1000 1” x 2” labels per battery charge

Physical and Environmental Characteristics

The BMP®61 printer has the following physical and environmental characteristics:

Note: The table below refers to the BMP®61 printer only. Consumable performance 
may vary.

Physical Metric Units U.S. Units

Dimensions 330 x 110 x 107 mm 13.0” L x 4.3” W x 4.2” H

Weight (with battery pack) 1.61 kg 3.55 lbs 

Environmental Operation Storage

Temperature (Printer)

Note:  Prolonged 
exposure of the printer 
to direct sunlight is not 
recommended.

4° to 43° C (40° to 110° F)

Be mindful, when using the 
AC adapter with the printer, 
that the AC adapter is rated 
at a maximum temperature 
of 30° C (86° F). 

-18° to 43° C (0° to 110° F)

Relative Humidity 
(Printer)

20% to 90% (non-
condensing)

10% to 90% (non-
condensing
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External View
External View

1 Cover (media well) 9 Printhead lock lever

2 Cover release latch 10 Strap upper attachment loop

3 AC adaptor port 11 Tripod attachment screw hole

4 USB port (computer connection) 12 Battery door latch

5 USB host port (flash drive) 13 Battery door (battery well)

6 Strap lower attachment loop 14 Magnet attachment screw holes

7 Cutter lever 15 Bulk or external media feed path

8 Ribbon 16 Serial number and WiFi emblem 
(for select models)
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Power Source
Power Source

Power is supplied to the BMP®61 printer from a BMP41-BATT NiMH battery pack, 
or from an AC power adapter. 

Do not expose batteries to temperatures above 60oC (140oF).
Do not disassemble or mistreat the battery pack.
Do not attempt to replace components in the battery pack.
Use only the BMP41-BATT rechargeable battery pack in the BMP61 
printer.
Do not allow metal or other conductive materials to touch the battery 
terminals.
Do not use any charger other than that specifically for use with the 
battery pack.
Do not use any AC adapter other than that specifically for use with the 
BMP61 printer.

Keep the battery pack away from heat sources.
Keep the battery pack away from water. 
Never lay objects on top of the battery pack. 
Store your battery pack in a cool, dry place. 
Keep the battery pack out of the reach of children. 
The battery pack must be recycled or disposed of properly according 
to federal, state, and municipal regulations. 
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Loading the BMP41-BATT NiMH Battery Pack
Loading the BMP41-BATT NiMH Battery Pack

1. On the backside of the 
printer, push down on 
the door release latch 
and swing the battery 
compartment door up 
and out. (The door will 
come off.)

2. With the battery label 
facing outward, insert 
the battery pegs into the 
peg slots at the top of 
the compartment; then 
tip the battery 
downward into place.

3. Re-insert the battery 
door tabs at the base of 
the compartment and  
swing the battery 
compartment door 
closed, snapping it into 
place.
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AC Power Adapter
AC Power Adapter

The printer can be powered through an AC/DC power adapter. When the adapter 
is plugged in, it is also charging the BMP41-BATT NiMH battery (if installed).

Use only the 18 VDC, Brady AC/DC adapters, shown below, for 

supplying power to the BMP®61.

Brady AC Adapters

Attaching the Adapter

Catalog Number Region

BMP41-AC North America, 
Australia

M50-AC-INTL Europe

M50-AC-AR Argentina

M50-AC-BR Brazil

1. Insert the round end of the adapter 
cable into the plug-in port on the 
left side of the printer.

2. Plug the female end of the electrical cord into the 
opposite side of the adapter.  Plug the male end of 
the electrical cord into an electrical outlet.
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Quick Charger
Quick Charger
The battery quick charger is an accessory that can be purchased through your 
BMP61 distributor. While the battery is charged from inside the printer when the 
AC adapter is attached, there may be times when you want to have another 
battery fully charged and ready to use when the AC adapter is not available. To 
charge a battery outside the printer, use the BMP-41-QC Quick Charger. The 
Quick Charger includes the charger, an AC adapter and electrical cord.

1. Insert the round end of the adapter 
cable into the plug-in port on the back 
of the quick charger.

2. Plug the female end of the electrical cord 
into the opposite side of the adapter.  Plug 
the male end of the electrical cord into an 
electrical outlet.

3. Insert the battery into the charger 
with the label facing toward the front 
of the charger.

The light on the front of the charger appears 
red when the battery is not charged. It changes 
to green when the battery is fully charged.
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Connecting
Connecting

The BMP®61 Label Printer is 
equipped with a USB port to connect 
to a computer and a USB host port to 
be used with a flash drive. Labels 
created in various applications (such 

as LabelMark™ Labeling Software or 
Brady Mobile Software) can be 

printed on the BMP®61. You can also 
copy data files and graphics between 
printers by placing the files on a flash 
drive which can be connected directly 

to the BMP®61 printer. 

Connecting to a PC 

In order to send data from a Brady PC labeling program to the BMP®61 printer, 

you must install the BMP®61 printer driver. The printer drivers can be found on the 

Product CD enclosed with your BMP®61 printer package.

To install the printer drivers:

1. Insert the Printer Drivers CD into the CD 
drive of your computer. 

2. Run Setup.exe, then follow the prompts 
on the screen.

3. When prompted by the installer 
program, attach the small end of the 
USB cable to the printer, then the flat 
end of the cable to the PC.

4. Turn the printer on.

On the PC, “Found New Hardware” pops up in the lower right corner of the screen 
and the printer driver wizard is launched.

5. Follow the prompts in the printer driver wizard.

Download Print Drivers

You can also download the print drivers from the Brady website, such as 
www.bradyid.com, or your local site. On the website, choose Technical 
Support>Downloads, then follow the instructions on the screen.
1-10 BMP®61 Label Printer User’s Manual
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Connecting
Pause/Cut Preference

After the printer driver is installed, access the printer and set the Pause/Cut 
preference.

1. In Windows XP, click Start, then choose Settings>Printers and Faxes.

OR

In Windows 7, click Start, then choose Devices & Printers.

OR

In Windows 8 or Windows 10, using the Search feature in the Charms bar, 
search for Devices and Printers.

2. In the list of available printers, right click BMP61 and choose Printing 
Preferences.

The Layout tab of Printing Preferences displays.

3. Click  button.

4. On the Advanced Options screen, click Properties button for Custom Settings.
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Connecting
5. On the Custom Settings screen, click the down arrow in Cutter Option field 
and select if you want to pause the printer for cutting at the end of each label 
or at the end of the job.

6. Click OK to accept the changes. (You may have to click OK a number of times 
as you back out of the Printing Preferences screens.)

Wireless Driver Installation

You can determine if your printer supports WiFi communication by checking for 
the "WiFi-installed" label on the inside of the printer cover. The Wireless drivers 
and driver installation instructions can be found on the Brady Printer Drivers CD.

1. Insert the Brady Printer Drivers CD into the CD drive of your computer.

2. Follow the prompts on the screen for installation of the WiFi driver.

Note: WiFi units are always enabled. The WiFi cannot be turned off.
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Firmware Upgrades

Future upgrades to BMP®61 firmware can be downloaded from Brady’s website. 

Note: Note: Your current firmware version can be found on the Config option of the 
Setup function. See "Config” on page 1-50.

To upgrade the firmware:

1. From your PC, access www.bradyid.com/BMP61.

2. Click Technical Support>Downloads.

3. From the list of download options, click Firmware then, from the list of 
products, select BMP®61.

The firmware download is packaged in a .zip file. 

To begin the download:

4. Click Begin Download button .

5. Placed the downloaded .zip file in the PC directory of your choice. 

Note: If you do not select a directory, the .zip file will default to your "Downloads" 
directory.

6. Open the downloaded .zip file, press [Ctrl+A] (to select all) and click Extract 
in the .zip file window.
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7. In the pop-up Browser, select the drive and directory where the extracted files 

should be placed, then click Extract .

8. Locate the directory containing the extracted files and double click the 
Upgrade folder.

9. Double click Setup.exe.

10. From the drop down list, select your preferred language, then click 

.

11. On the Welcome screen, click  again.

12. On the Installation Folder screen, the upgrade files will be placed in a default 

directory or you can select a different directory, then click . 

Note: If you are accepting the default directory, please make note of where it is 
located so you can access the upgrade files.
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13. On the Shortcut screen, click .

14. On the Ready to Install screen, make note of the Install folder and Shortcut 

folder, for future reference, then click .

15. When the firmware download is successfully installed, click .

16. Now locate the directory where the firmware was installed and double click 
BMP61 Update Utility.exe.

17. Follow the prompts to connect the BMP61 printer to your PC, turn the printer 

on, then click Upgrade BMP61 .

18. When successfully loaded, turn the printer off, then turn it on again.

The new firmware is available for use.
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Y & B Values

The Y & B values are parameters loaded onto the BMP61 printer to enable the 
printer to better work with current media and new media that might be added to the 
unit. 

New Y & B values are continuously being generated, so for optimum performance 
of your BMP61 printer and materials, you should upload the new values whenever 
you add enhancements, changes, or new parts to your BMP61 printer. 

Updating Y and B Values

To upload new Y and B values:

1. Select SETUP.

2. Select Config.

The currently installed version of the Y and B values can be found in the lower 
right corner of the screen.

1. From your PC, access www.bradyid.com/BMP61.

2. Click Technical Support>Downloads.

3. From the list of download options, click All Downloads then, from the list of 
products, select BMP61 Database Update (Rev Y-#, B-#).
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4. Click Begin Download button .

5. Placed the downloaded .zip file in the PC directory of your choice.

6. Extract all the files in the .zip file and transfer the extracted files to the root 
directory of a flash drive. 

7. Place the flash drive into the USB port of the BMP61 printer.

The printer detects the flash drive automatically, showing you both the version of 
the files on the printer, and the version of the files on the flash drive.

8. With a checkmark next to the files you want to upgrade, select Upgrade or 

press Enter  on the keypad. 
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9. Select Yes  to confirm the upgrade.

Once the printer is updated, you can use the files on the flash drive to upgrade 
other BMP61 printers you may have in your possession. 

10. If you have more printers to update, select Ignore  on the Delete from 

External Media screen.

This retains the upgraded Y & B files on the flash drive.

11. If this is the only printer to update, select Delete .

This deletes the Y & B upgrade files from the flash drive ONLY (not from your 
printer). 
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Ribbon
Product numbers for ribbons for the BMP61 printer begin with M61. Example: 
M61-R4310. 

Remove Ribbon

1. Flip the printhead lock lever 
backward (to the right) to disengage 
the printhead.

2. Grasp the ribbon and gently slide out of 
printer.
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Load Ribbon

Note: Load the ribbon BEFORE loading media (labels). Loading the ribbon after 
loading the media can cause damage to the ribbon.

1. Before inserting, remove any ribbon slack by rotating the take-up spool end 
clockwise.

2. Carefully slide the ribbon cartridge into the printer until it seats firmly against the 
metal frame, then flip the printhead lock lever forward (to the left) to re-engage the 
printhead.
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Media

Brady labels come equipped with smart-cell technology that enables the printer to 
recognize the type of label and automatically sets many label formatting details.

For optimum performance, it is recommended that you use genuine Brady BMP61 
labels. Labels can be loaded with the power on or off.

Note: TLS2200 media is forward compatible to BMP61 and cross-compatible to 
BMP71 printers.  TLS2200 media continues to work in TLS2200 and PC-Link. 

Before inserting labels, be sure to remove the protective tape covering the leading 
end of the labels.

Loading Media

1. To open the printer cover, place your 
thumb under the finger tab and push up.

2. With labels coming off the top of the 
spool, grasp the smart cell handle and 
insert the labels straight into the smart cell 
reader compartment, gently pushing until 
it clicks into place.
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Media
3. If using anything but a 2-inch width 
media, slide the media guide to the left 
until it fits snugly up against the media 
roll and clicks into place.

4. Feed the leading edge of the media roll 
through the guide slots until it stops.

Note:  Make sure the printhead is engaged by 
flipping the printhead lock lever forward (to the 
left) before inserting media into guides.

5. With the Power on, press Feed button once to feed media under printhead.

6. Close the cover by pushing down on it until it snaps into place.
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Unload Media

1. To open the printer cover, put your thumb 
under the finger tab and push up.

2. Flip the printhead lock lever backward (to 
the right) to disengage the printhead.

3. If label spool is not empty, gently rewind 
the spool with your finger to back the 
unused media out from under the print 
head.

4. Grasp the media roll smart cell guide and 
gently pull up out of the tape well.

5. If you do not want to load any more media, close the printer cover by pressing down on 
the cover until it catches.
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Loading Bulk Media

1. Remove the BMP61 label spool and the 
label feed ramp from the box.

2. On the bulk media box, push Tab A and 
C in, then pull the perforated flap down 
and tear off.

3. Attach the label feed ramp to the 
bottom of the perforation, with the ramp 
arms on the outside of the box.

4. Attach the ramp hooks to the outside of 
the bulk label feed path on the printer. 
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B-593 Raised Panel Labels

5. Insert the BMP61 label spool  (smart 
cell facing left) into the printer. Adjust 
the media guide as needed.

6. Pull the loose end of the bulk media out 
of the box punch-out and thread over 
the tray and into the bulk label feed path 
on the printer. 

7. Continue to feed the leading edge of the media roll over the label spool and through the 
guide slots until it catches. 

8. Turn the printer on and press [FEED] to feed the media through the printer. 

9. Close the printer cover.

1. Open the printer and insert an empty 
BMP61 label spool into the printer. (See 
instructions on page 1-21.)

2. Keeping the label media in the box, 
place the box behind the printer, then 
feed the leading edge of the B-593 
media through the external media feed 
path, over the label spool and through 
the guide slots until it stops.

3. Turn the power on. 

4. Press Feed. 

5. Leave roll door open during printing.
BMP®61 Label Printer User’s Manual 1-25



Attaching the Strap
Attaching the Strap 

The strap can be attached to the back of the printer to provide a secure grip 
when holding the printer in your hand or hanging the printer on a hook.

1. First, remove all labels from the media 
well.  Then, with the scratch (burr) 
fastener facing down, thread the Double 
D-ring handstrap through the loop on 
the lower portion of the back of the 
printer.

2. Still on the back of the printer, feed the 
strap under the loop at the top of the 
printer, directly into the media well. 

Then turn the printer over and from 
inside the media well, feed the strap out 
through the top of the loop.

3. Pull the loose end of the strap under and 
through both D-rings.

4. Separate the two D-rings so there is 
enough space for the strap to pass 
between them.
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5. Weave the loose end of the strap back 
over the first (lower) ring, then under 
and through the second (top) ring.

6. Pull the loose end of the strap until it 
feels tight, then press the scratch (burr) 
fastener against the strap so it lays flat.

7. Slip your hand through the strap to 
provide a secure grip when holding the 
printer.

8. Or, use the third D-ring at the bottom of 
the printer to hang the printer on a pole 
or hooked device.
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Recycling the Label and Ribbon Cartridge

Cartridges need to be recycled in accordance with local regulations. Before 
recycling, the used cartridges must be pulled apart to release the individual 
components. These various components must then be recycled in the correct 
recycling bins.

Materials

• 1/4-inch blade flathead screwdriver 

• Safety Glasses

• Safety Gloves

ALWAYS wear Personal Protective Equipment when dismantling a cartridge.

Dismantling the Ribbon

To dismantle the ribbon:

1. Using your thumbnail, press the clear plastic locking tab down. While holding 
the tab down, insert the blade of the screwdriver above the smart cell and 
slide downward. The smart cell easily slides out for removal.  
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Recycling the Label and Ribbon Cartridge
2. With the yellow ribbon cover facing up, insert the blade of the screwdriver, one 
at a time, in through the five locking tab holes to depress the locking tabs. 
While depressing each tab with the screwdriver, use your thumb or finger to 
apply upward pressure on the ribbon cap finger tab. The ribbon cover 
releases and separates from the rest of the assembly.  

3. Using the screwdriver, pry out the metal ribbon spring from the inside of the 
yellow ribbon cap. 

4. Once the spring is removed, turn the ribbon cartridge on its side and allow the 
ribbon and white spools to fall out.  

5. Unwind the ribbon from the spools, then gently peel the ribbon end from the 
weak adhesive that affixes the ribbon to the spool.
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Dismantling the Cartridge

To open the cartridge:

1. Unwind any remaining label meda from the spool, then gently peel the end of 
the media off of the spool to separate.

2. Grip the media assembly just behind the black end cap (containing the smart 
cell).

3. With your thumb, apply pressure to the back of the black end cap to separate 
the cap from the media cartridge core. 

 

4. From the back side of the black end cap, press the blade of the screwdriver 
against the locking tabs, applying outward pressure. This will release the 
smart cell.

5. Slide the cardboard core off of the plastic cartridge core.
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Recycling Components

These components should be removed from the cartridge and recycled according 
to the following guidelines.

No. Component Material Recycle Bin

1 Ribbon Spools (White) ABS #9 ABS

2 Ribbon Smart Cell
Media Smart Cell

Electronic Electronic Waste

3 Ribbon Cartridge (Clear) Polycarbonate (PC) #7 Other

4 Ribbon Washer (White) PTFE #7 Other

5 Media Cardboard Core Cardboard #20 C PAP

6 Media End Cap (Black) PP #5 PP

7 Media Cartridge Core (Gray) PP #5 PP

8 Ribbon Washer (Cork) Cork/Nitrile Butadiene #51 FOR

9 Ribbon Spring Stainless Steel #40 FE

10 Ribbon Cap (Yellow) ABS #9 ABS
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Power On

To turn the system on or off:

1. Press Power .

To preserve battery life, when the printer detects a time of inactivity, it 
automatically shuts down. Any data on the screen at the time of auto shutdown is 
retained and available the next time the [Power] key is pressed to restart the 
printer. (See page 1-50 for information on setting the shut off delay time.)

The first time the printer is turned on, you may want to choose a language in which 
to display screen items. Language selection is performed in the Setup function. 
(For more information, see “Setup Language” on page 1-52.)

Whenever the printer is powered on, the system performs an initialization process. 
Part of this process is recognizing the media installed. While it is possible to power 
on the printer without installing media, if you choose not to install any, the printer 
reverts to the last media installed in the printer. 
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Display Screen

The display screen enables you to view font attributes and other formatting 
features directly on the screen while you are entering and editing data. 

The screen displays one label, or one area on a multi-area label, at a time. For 
labels with multiple areas, use Print Preview (see page 5-2) to view all areas 
together.

Status Information

The header bar (top) and status bar (bottom) display permanently on the screen 
and contain the following information:

1 Font size with Autosize indicator 7 Editor screen

2 Degree of text rotation in Editor 8 Ribbon remaining

3 Media product and size 9 Battery charge remaining

4 Media type 10 Indicates Caps Lock is on

5 Number of areas on current label 11 Media (labels) remaining

6 Number of labels in current file
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Navigation and Editing

Touch Screen

The BMP®61 printer uses touch screen technology to manipulate menus and data. 
Using your finger, or a stylus, touch the desired option on the display screen.

Touch Screen Basics

Using your finger or a stylus, use the following techniques to navigate through or 
access items on the touch screen.

Function Technique

Tap Quickly touch the screen.

Double tap Quickly touch the screen twice

Long press Touch the screen and hold briefly

Scroll Touch the screen and move stylus/finger with some 
velocity in one of the scrolling direction than release 
stylus/finger.

Flick Same as scroll but the purpose is to change content/pages 
in horizontal/vertical direction.  The Flick is a quick finger 
movement, faster than scroll.
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Keypad

The following descriptions are based on the QWERTY keypad. If you are using a 
different keypad (such as Azerty or Cyrillic), some of the keys may vary. Please 
refer to Appendix A for a full description of other keypad layouts.
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Function Key Description

1 Navigation Keys Navigation keys:

• In a line of text, move the cursor left 
or right a character at a time, or up 
and down a line at a time. 

• In menus, move the selection left or 
right in a primary menus; up or 
down through a secondary, or sub-
menu.

• In a dialog box, move up/down or 
left/right through the fields. In a field 
with a drop down list, after pressing 
OK, moves the cursor up or down 
through the list. 

• In Print Preview, scrolls left or right 
through multiple areas on a label.

2 ENTER Key • Adds a new blank line to a label.

• Accepts menu items and attributes.

3 Print Key Prints all labels in a label file. (Refer to 
"Print” on page 5-1).

Multi-Print Key Brings up options to set various print 
parameters (such as number of copies, 
print range, and mirror print) before 
printing.

4 Feed Key Feeds the media through the printer. 
(Refer to "Loading Media” on page 1-
21).
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5 Backspace Key • Removes characters one at a time, 
moving to the left.

• Backs out of menu options and 
functions, one screen at a time.

Note: Depending on how deep you are 
into menus and functions, you may 
have to press Backspace multiple 
times.

Clear Key Clears data or all menus from the 
screen.

6 Decimal Point Adds a decimal point or period (full 
stop).

7 Move to Next 
Area Key
(Refer to "Go To 
Label or Area” on 
page 3-17)

On a multi-area label, moves to the next 
area from the current area.

Move to Previous 
Area Key

In a multi-area label, moves to the 
previous area from the current area.

8 Move to Next 
Label Key
(Refer to "Go To 
Label or Area” on 
page 3-17)

In a multi-label file, moves to the next 
label from the current label.

Move to Previous 
Label Key

In a multi-label file, moves to the 
previous label from the current label.

9 Label Key Adds, removes, and formats labels in a 
file. (Refer to "Add Label or Area” on 
page 3-15.)

Area Key Adds, removes, and formats areas on a 
label. (Refer to "Add Label or Area” on 
page 3-15.)

Function Key Description
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10 Shift Key When Caps Lock is turned off, used in 
conjunction with a single letter to enter 
that letter in uppercase.

Highlight Text Highlights (selects) text on the editing 
screen, left or right a character at a 
time, enabling you to add font attributes 
(bold, italics, underline) to text already 
entered. (Refer to "Pre-Existing Data” 
on page 3-3.)

Font Size 
Increment

On the editing screen, increases or 
decreases the font size, a point at a 
time. Hold the [SHIFT] key while 
pressing the up or down navigation key.

Print History Brings up Print History menu. (Refer to 
"Print History” on page 5-7.)

11 Font Key Provides font sizes and attributes (such 
as bold and italics). (Refer to "Font” on 
page 3-1.)

Caps Lock Key Acts as a toggle to lock text into 
uppercase as data is entered. Press 
once to turn Caps Lock on; press again 
to turn Caps Lock off.

12 FN Key • Used in conjunction with the 
alternate function (displayed in 
gold) on some of the keys. Press 
the FN key, then press the 
alternate function key. 
OR
Hold the FN key while 
simultaneously pressing the key 
that has the alternate function.

• Used to access special characters 
on the alphabetical keys.

Function Key Description
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13 List Key Enables you to produce multiple labels 
with variable information from a single, 
formatted label (main document) and a 
structured data source. (Refer to "List” 
on page 3-36.)

Barcode Key Places a text string in Barcode format, 
toggling the barcode on and off. (Refer 
to "Barcode” on page 3-27.)

14 Symbol Key Accesses the various symbols available 
on the printer. (Refer to "Symbols” on 
page 3-8.)

Graphics Key Accesses user supplied graphics 
loaded onto the printer. (Refer to 
"Graphics” on page 3-10.)

15 International Key Accesses characters specific to some 
international alphabets with diacritical 
and accent marks incorporated into the 
characters. (Refer to "International 
Character Sets” on page 3-11.)

Setup Key Defines the printer’s default 
parameters. (Refer to "Setup” on 
page 1-49.)

16 Superscript Key • Places the next typed character in 
superscript format, displaying 
slightly above the line of text. 

• Will place multiple characters in 
superscript if the characters are 
highlighted first. (Refer to "Pre-
Existing Data” on page 3-3 for 
information on highlighting 
characters.)

Function Key Description
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Subscript Key • Places the next typed character in 
subscript format, displaying slightly 
below the line of text.

• Will place multiple characters in 
subscript if the characters are 
highlighted first. (Refer to "Pre-
Existing Data” on page 3-3 for 
information on highlighting 
characters.)

17 Insert Time Key Inserts the current time, as set on the 
printer.

Insert Date Key Inserts the current date, as set on the 
printer. 

18 Serial Key Sets the values for single, multiple, or 
linked serialization. (Refer to 
"Serialization” on page 3-31.)

Preview Key Previews the label as it will look when 
printed. (Refer to "Print Preview” on 
page 5-2.)

19 Label Type Key Accesses the different 
applications/label types installed (i.e., 
wiremarker, flags, terminal blocks, etc.). 
(Refer to "Label Types” on page 6-1.)

File Key Saves, opens, or deletes a label or set 
of labels. (Refer to "Label Files” on 
page 4-1.)

20 Power Key Turns the printer on and off.

Function Key Description
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Menus

Menus display at the bottom of the screen and are activated by the function keys. 
Use navigation keys or the Touch screen to access the different menu items. 
Continue to press the navigation keys to access the overflow menus or, using 
your finger, scroll through the menus. When you have reached the last menu item 
displayed, the menus cycle back to the first menu item.

Figure 1-1.  Menus

To access menus using the keypad:

1. Press the function key for the menus you want to access.

The menu choices for that particular function display. 

2. Press the left/right navigation keys to access the main menu items.

When you access a menu item, if a sub-menu is available, it immediately pops-up. 

To access a sub-menu:

1. Press the up/down navigation keys

An accessed menu displays with a yellow bar around it.

2. To activate the highlighted sub-menu, press Enter  or touch screen.

A menu option remains in effect until a different menu option is activated. 
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To access menus using the touch screen:

1. Press the Function key for the menus you want to access.

2. Touch the desired main menu option.

3. If sub-menus are available, touch the desired sub-menu option.

The various functions and menus are discussed in further detail in the Formatting 
section of this manual, starting on page 3-1.

Cancel Menus

To remove menus from the screen, using the keypad:

1. Press Backspace .

Note: If you are deep into sub-menus, you may have to press Backspace several 
times to clear all menus from the screen. Menus cleared from the screen will not 
retain any edited menu data.

To remove menus from the screen, using the touch screen:

1. Tap anywhere outside the menu items.
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Dialog Boxes

Some function keys display dialog boxes, rather than sub-menus. 

Note: You will know that a dialog box is associated with a menu if a sub-menu does 
not immediately pop up when highlighting or selecting the main menu option.

To access a menu’s dialog box using the keypad:

1. Press Enter  on the menu item.

A dialog box displays. 

Figure 1-2.  Dialog box

2. Press the up/down and left/right navigation keys to move to the different 
fields.

To access a menu’s dialog box using the touch screen:

1. Touch the menu item.

2. Touch the desired field you want to edit.
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Drop Down Field Lists

If a field has a drop down list associated with it, a small arrow displays on the right 
side of the field. 

To select an option from the drop down list, using the keypad:

1. Press Enter  to open the drop down list.

2. Use up/down navigation keys to highlight the desired option.

3. Press Enter  to select the option.

The item is selected and the list collapses.

Figure 1-3.  Drop down fields

To select an option from the drop down list, using the touch screen:

1. Tap the down arrow of the drop down list to expand the list.

2. Tap the desired option in the list. 

The item is selected and the list collapses.
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Data Fields

Data fields require user-supplied data. Some fields may have default data already 
entered. When you access a field with pre-existing data, the data highlights and 
you can enter new data directly over the highlighted data.

To access data fields, using the keypad:

1. Use navigation keys to navigate to the data field.

2. Enter data using the keyboard.

3. Use navigation keys to move off the field after entering data.

Figure 1-4.  Data input fields

To access data fields, using the touch screen:

1. Tap the desired data field. 

If the data field is active (contains data), tapping the field one time highlights the 
data and you can type directly over it. If the data field is not active (does not 
contain data), tapping one time activates the field by placing the cursor in the field.

2. Enter the desired data in the field.
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Spinner Boxes

A spinner box lets you toggle through a range of values in a field. 

To use a spinner box, using the keypad:

1. Navigate to the field containing the spinner box.

2. Press Enter .

3. Use the up/down navigation keys to toggle through the range of values.

4. When the desired value is reached, press Enter .

Figure 1-5.  Spinner boxes

Note: Some fields containing spinner boxes allow you to type numbers directly in 
the field. The presence of a cursor in the field indicates you can directly enter 
numbers.

To use a spinner box, using the touch screen:

1. Tap the field containing the spinner box.

2. Tap the up arrow to incrementally increase the value in the field. Tap the down 
arrow to decrement the field value.
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Radio Buttons and Option Boxes

In a series of radio buttons, only one radio button option can be selected at one 
time. In a series of option boxes, any number of options can be selected at one 
time.

To check or uncheck a radio button or option box, using the keypad:

1. Navigate to the desired option.

2. Press Enter .

The option box will display a checkmark indicating it is active. The radio button will 
display a dot inside the button.

3. To deactivate an option box, navigate to the option box and press Enter. 

The checkmark is removed.

4. To deactivate a radio button, navigate to another radio button and press Enter.

Figure 1-6.  Radio buttons, Option boxes and OK button

To check or uncheck a radio button or option box, using the touch screen:

1. Tap one time on a radio button or option box to activate it. 

The option box will display a checkmark indicating it is active. The radio button will 
display a dot inside the button.

2. Tap one time to deactivate the option box (remove the checkmark). 

3. To deactivate a radio button, simply tap a different radio button.
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Accept Dialog Box Edits

To accept all edits in a dialog box, using the keypad:

1. Navigate to  at the bottom of the dialog box.

2. Press Enter .

To accept all edits in a dialog box, using the touch screen:

1. Tap  at the bottom of the dialog box.

Cancel a Menu or Dialog Box

To cancel a menu or dialog box without accepting changes, using the 
keypad:

1. Press Backspace .

Note: You may have to press Backspace more than once to exit out of all menus.

To cancel a menu or dialog box without accepting changes, using the touch 
screen:

1. Perform a downward flick in the dialog box header.
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Setup
Setup

Figure 1-7.  Setup menu options

The Setup function key is used to determine the default settings for the printer. 

To change Setup functions:

1. Press Setup .

Pause/Cut

The Pause/Cut function allows you to remove a label from the printer before 
another label starts printing. If this feature is turned on, when printing a string of 
labels, cutting a label initiates the next label to print. 

To turn on the Pause/Cut function:

The Pause/Cut menu, being first in the list of primary menus, is already selected.

1. Select On.
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Setup
Config

The following settings can be found under the Config menu in the Setup function.

Figure 1-8.  Printer configuration in Setup settings

The Shut Off Delay sets the auto-off time-out. This refers to the number of minutes 
of inactivity after which the printer automatically shuts off. 

When using the AC adapter, power is constant so there is no drain on the battery. 
In this case, you can turn off the Shut Off Delay by choosing No Shut off (AC).

The Brightness setting increases or decreases the brightness of the display 
screen. 

The Firmware version currently installed on your printer can be found in the lower 
left corner of the screen.

The Clean Printer button is used in conjunction with the electronic cleaning card, 
which can be purchased separately. (See "Internal Components” on page 7-2 of 
this manual for instructions on how to clean the printer.)
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Setup
Time/Date

The following settings can be found under the Time/Date menu in the Setup 
function. Set the Time/Date options upon initial start-up of the printer.

Figure 1-9.  Time/Date settings in Setup function

Units

The Units setting is used to configure label parameter measurements for the 
printer. The units are:

• Inches

• Millimeters

Once configured, you do not have to indicate “inches” or “millimeters” (or their 
globally accepted abbreviations or marks) when entering numbers in data fields. 
Likewise, in any scale or range of measurement field (using spinner boxes or in a 
drop down list), the range of measurements will automatically configure to the 
units selected in the Setup function.
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Setup
Language

Depending on the printer keyboard type you are using, the following languages 
can be found under the Language menu in the Setup function. (See "Keyboard 
Configurations” on page A-1 for information on the different keyboard types.)

Initial Language Setup

When turning the printer on for the first time, immediately go to the Setup function 
and choose the language in which you want all printer menus, functions, and data 
displayed.

1. Press Setup .

2. Select Language.

3. Select the desired language.

English Dutch Danish Turkish Romanian

French Norwegian Czech Slovakian Russian

Spanish Finnish Estonian Slovenian Japanese

German Swedish Hungarian Croatian Simplified Chinese

Portuguese Italian Polish Bulgarian Traditional Chinese
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Setup
Font Settings

Use the Font Settings to indicate if you want the font size to be measured in points 
or millimeters.

Figure 1-10.  Font settings in Setup function

Touchscreen Calibration

Calibrate the touchscreen to the desired sensitivity (soft or hard touch).

To calibrate the touchscreen:

1. Press Setup .

2. Select Touchscrn Calibr .

Note: Touchscreen calibration is located to the right of Font Settings. Scroll to the 
right to access Touchscrn Calibr button.

3. Follow the instructions on the screen.
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2 Getting Started
Creating a Text Label

This section describes the process of creating a text label with minimal formatting, using 
basic editing techniques, and printing the label.

Entering Text

Before entering label text, be sure the media cartridge is loaded and the power is ON.

The vertical bar on the display screen is the cursor and is the starting point for every label 

you create using the BMP®61 printer. Begin entering text at the position of the cursor. The 
cursor moves across the screen as you enter data. If you want another line of text, press 

[ENTER] .

Editing Text

If you have entered some text in error or want to change the content or format of your 
label, edit the information before printing.

Inserting Text

To insert additional text within a line of text:

1. Using navigation keys, position the cursor at the point where text should be inserted.
OR
Touch the screen at the point where text should be inserted.

2. Enter the text.
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Creating a Text Label
Existing data positioned to the right of the cursor moves progressively to the right 
to make room for the inserted text. As more data is added to a line of text, the font 
size automatically decreases a point at a time until the smallest font size is 
reached. At that point you cannot add anymore data to that line of text and the 
following error message displays.

To remove the error message:

1. Press Enter .
OR
Touch the error message screen.

2. Press [ENTER]  to start another line of text. 

Deleting Text

To remove characters, one at a time, from the position of the cursor TO THE 
LEFT (backwards):

1. Press Backspace .
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Creating a Text Label
Clear

[CLEAR] is used to clear data from the screen or cancel a function. 

To Clear data:

1. Press Clear .

You are presented with two options:

• Clear Label Data

• Clear All

Clear Label Data removes all data on the label, but leaves the formatting in place 
(e.g., font size, number of areas, etc.)

Clear All removes all data and formatting from the label.

2. Select the desired option.

If using Clear All, a message displays asking confirmation. 

3. Press Enter  to confirm the deletion. 

OR
Touch Yes.

If you do not want to delete the labels:

4. Press Backspace  to cancel the Clear All function. 

OR
Touch No.

You are returned to the screen with all labels and data intact.
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Creating a Text Label
Cancel Functions

Backspace  is also used to cancel functions, a menu, or dialog box. 
When pressing Backspace in the middle of a function, you are walked out of the 
function a screen at a time. You may have to press Backspace several times to 
completely exit the function. (See page 1-36 for information on how to cancel 
functions using the Touch screen.)

Error Messages

If a function does not operate under current conditions, an error or information 
message displays indicating the problem and/or offers situational advice. Read the 
message carefully and follow the instructions.

To remove an error message from the screen:

1. Press Enter .

OR
Touch the error message screen.

Default Settings

Default settings are determined by the printer for the installed media. When the 
label supply and/or application label type is reloaded, it will return to these 
settings. 
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Font AutoSize
Font AutoSize

Autosize starts with the largest font size that fits on the label. When a line of text 
reaches the edge of a label it scales downward until you press [ENTER] or the 
minimum font size is reached. When working with autosize and multiple lines of 
text, all lines on a label maintain the same size. 

Autosize is turned on for all labels and is displayed as an ‘A’ in front of the font 
size in the upper left corner of the Header bar.

Figure 2-1.  Text entered with Autosize turned on
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Printing a Label
Printing a Label 

WARNING

DO NOT insert fingers near cutter. It could pinch or cut. 

To print a label:

1. Press Print .

After printing, to cut the label: 

2. Pull the cutter lever forward 
(towards you) as far as it will 
go. 

Printing from the BMP®61 printer 
occurs in the background, meaning 
you can continue to edit or create 
new labels while a label is printing. 
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3 Formatting
Formatting refers to the layout, structure, and appearance of a label. Different formatting 
features can be found under the Font, Label, and Area functions.

Font 

Figure 3-1.  Font menu options 

Character/line formats are called attributes that change the appearance of the fonts, such 
as size, weight (bold), and angle (italics). 

There are two fonts available with the BMP61 printer, Brady Fixed Width and Brady 
Alpine. Both fonts give you the option of displaying a zero (0) with or without a slash 

through it ( ). You can change the font when configuring the printer. (For more 
information, see "Font Settings” on page 1-48.) 

Note: You cannot download any other fonts to the printer.
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Font
Size

Font size applies to an entire line of data at a time and is measured in point size or 
millimeters, as determined in the Setup function. 

To change the size of the chosen font:

1. Press Font .

A pop-up menu displays the available font sizes for the media installed.

2. Select Size, then select the font size desired.

If the desired size is not displayed, you can manually enter a font size within the 
valid size range.  This option is available under “Custom” of the Size menu.

To manually enter a font size:

3. Select Custom and enter the font size.

4. Press Enter .

When entering a custom font size, a minimum/maximum range is presented to 
accommodate the label size loaded in the printer. The minimum size reflects 
readability and the maximum size accommodates proper fit on a label. If you enter 
a size smaller than the minimum or larger than the maximum, an error message 
displays indicating the entered size exceeds lower or upper limits.

To remove the error message:

5. Press Enter .

OR
Touch the error message screen.
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Font
Font Attributes

Font attributes (bold, italics, underline) can be applied to individual characters in a 
line of text.

To turn an attribute on:

1. Position the cursor where the attribute should take affect.

2. Press Font .

3. Select the desired attribute, then select ON.

4. Enter the text to be affected by the attribute.

If applying the attribute to text as it is being typed, the attribute stays on until it is 
turned off, or until you move to a new area or label.

To turn the attribute off:

1. Press Font .

2. Select the attribute, then select OFF.

Pre-Existing Data

To apply an attribute to previously entered text:

1. Hold Shift  while moving the cursor with the navigation keys across the 

characters to which the attribute will be applied.

OR

1. At the beginning of the character string that will display the attribute, touch 
and briefly hold, the screen until the cursor disappears.

2. Drag your finger across the screen to the end of the character string that will 
display the attribute.

This highlights the data.
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Font
Note: Highlighting works on a line-by-line basis. You cannot highlight more than 
one line at a time.

3. Press Font .

4. Select the attribute, then select ON.

All highlighted text displays the attribute.

To remove the highlighting from the characters, press any navigation key or touch 
anywhere on the screen.

To remove an attribute that was previously applied to some text:

1. Highlight the text containing the attribute to be removed.

2. Press Font .

3. Select the attribute to remove, then choose OFF.

The attribute is removed from the text.
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Font
Expand/Condense

Expanding and condensing data affects character width and the spacing between 
characters in a word.  Data can be expanded or condensed according to 
predefined percentages. 

Figure 3-2.  Expaned and condensed text

To Expand or Condense data, as it is entered:

1. Position the cursor where Expand or Condense should take affect.

2. Press Font .

3. Select Exp/Cond, then select the percentage desired.

While entering data, the expand or condense attribute stays on until it is returned 
to 100%, or until you move to a new area or label.

To expand or condense pre-existing data:

1. Highlight the data. 

2. Press Font .

3. Select Exp/Cond, then select the percentage desired.

All highlighted text takes on the attribute. 

Standard Expanded Condensed
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Font
Superscript/Subscript

Superscript places a character slightly above the line of type and subscript places 
a character slightly below the line of type. The super- or subscript character also 
displays slightly smaller than the normal line of type. Superscript and subscript 
functions are on the numeric keypad.  Pressing either the superscript or subscript 
key applies that format to the next character typed.  It immediately turns off after 
the character is entered and you are returned to the normal line of type.  

To apply Superscript or Subscript:

1. Position the cursor in the line of text where the superscript or subscript 
character will display.  

2. Press Sup  or Sub .

3. Type the character to be displayed in superscript or subscript.

Only the character typed directly after pressing the superscript or subscript key is 
displayed in super- or subscript.

Multi-Characters

To place a number of characters in Super- or Subscript at one time, first enter the 
text, then highlight the characters to place in Super- or Subscript.

Figure 3-3.  Applying Subscript to multiple characters
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Font
To highlight multiple characters, using the keypad:

1. Position the cursor at the beginning of the character string that you want to 
display in Super- or Subscript.

2. Hold Shift  while moving the cursor with the navigation keys across the 

characters that will display in Super- or Subscript.

This highlights the characters.

To highlight multiple characters, using the Touch screen:

1. At the beginning of the character string that will display in Super- or Subscript, 
touch the screen, and briefly hold, until the cursor disappears.

2. Drag your finger across the screen to the end of the character string that will 
display in Super- or Subscript.

When you lift your finger off the screen, the character string is highlighted.

3. Press Sup  or Sub .

All the highlighted characters display in Super- or Subscript.

4. To remove the highlighting, press any navigation key.
OR
Touch anywhere on the screen.
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Symbols
Symbols

Figure 3-4.  Symbol categories

The BMP61 printer contains hundreds of symbols that can be used for a variety of 
applications. 

To add a symbol to the label:

1. Position the cursor at the point where you want the symbol to display.

2. Press Symbol .

OR
Touch the Header or Status Bar, then touch Symbol.

3. Select the symbol category. 

A symbols grid displays. Some of the grids are lengthy and may require scrolling 
to view all the symbols. 

4. Select the desired symbol.

5. Press Enter .

OR
Double tap the desired symbol.

The symbol displays with the same font size that is currently in use.
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Symbols
Remove a Symbol from Label

The symbol is the same as any other character. 

To remove a symbol from the label:

1. Postion the cursor to the right of the symbol.

2. Press Backspace .
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Graphics
Graphics

Graphics are symbols, logos, or other artwork supplied from an outside source, 
such as a PC. These graphics must be bitmap files (*.bmp) and can only be black 
and white. The BMP61 printer will automatically resize the graphic, but it is 
important to keep the graphic size approximate to the printed output (about 2-inch 
x 2-inch).

Download Graphics

Graphics are added to the BMP61 printer through the Import function. This 
function displays in the File menu if an external memory device is attached. 

To download personal graphics to the BMP61 printer:

1. Attach the external memory device containing the graphic you want to import 
to the BMP61 printer.

2. Press File .

3. Select Import>Graphics. 

4. Select the graphic to import.

Graphic files (.bmp) are stored in a specific folder used by the Graphics function. 
This folder is unavailable to the user and therefore, when importing a graphic, the 
destination screen does not display. You can view and use imported through the 
Graphics function. Unlike Symbols, imported graphics are not categorized. 
However, the most recently used graphic displays first in the window.

For a more comprehensive discussion of importing files, refer to "Using Files from 
an External Source” on page 4-11.

Add a Graphic

To add a personal graphic to your label:

1. Position the cursor at the point where you want the graphic to display.

2. Press Graphics .

OR
Touch the Header or Status Bar, then touch Graphics.

The graphics grid displays, with the most recently used graphic displaying first. 

3. Select the desired graphic.

4. Press Enter .

OR
Double tap the desired graphic.

The graphic displays with the same font size that is currently in use.
3-10 BMP®61 Label Printer User’s Manual



International Character Sets
International Character Sets

The BMP61 printer contains hundreds of internationally recognized characters, 
complete with diacritical marks. 

To add an international character to your label:

1. Position the cursor at the point where you want the international character to 
display.

2. Press the International key .

A list of international characters displays. 

3. Scroll through the list until the desired character is found.

4. Press Enter .

OR
Double tap the desired character.

The character displays with the same font size that is currently in use.
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Date and Time
Date and Time

To have the current date and/or time inserted on each label:

1. Position the cursor at the point on the label where you want the date and/or 
time to be inserted.

2. To insert the date, press Insert Date .

OR
Touch the Header or Status bar, then touch Date in the pop-up menu.

Figure 3-5.  Pop-up menu when Header bar is touched

3. To insert the time, press Insert Time .

OR
Touch the Header or Status bar, then touch Time in the pop-up menu.

The BMP®61 printer inserts the current Date or Time data using the current 
system clock value at the time of printing and the date/time format defined in the 
Setup function. (For more information, see "Time/Date” on page 1-45.) 

The date or time displays the selected format on the editing screen (e.g., 
mm/dd/yy or HH:MM). To view the actual date or time, use Print Preview (see 
"Print Preview” on page 5-2). 
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Labels and Areas 
Labels and Areas 

Figure 3-6.  Label menu options 

You can create a number of labels in one label file, each new label being inserted 
immediately after the current label. 
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Labels and Areas 
Figure 3-7.  Area menu options 

Areas are used to apply different formatting (such as justification, rotation, and 
frames) to different parts of a single label. Areas can only be added to continuous 
media set to auto length mode. However, area formatting can be applied to die cut 
labels that have pre-defined areas.

Note: You cannot set a fixed length of an area on a label that has multiple areas.  
The size of the area is based on the amount of data entered and the font size of 
that data.
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Labels and Areas 
Add Label or Area

Note: Labels cannot be added to files containing serialization.

To add a label to a label file:

1. Press Label .

OR, to add an area to a single label:

Press Area .

2. Choose Add.

The new label is inserted immediately after the current label and its number is 
reflected on the right side of the Header bar. Each label added will be of the same 
application and label type. 

A new area is inserted immediately after the current area and is reflected on the 
right side of the Header bar. The font size used on the first line of the previous 
area carries over to the new area.
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Labels and Areas 
Label Length

Auto length is the default for continuous media. With Auto Length, the label will be 
as long as it needs to be to accommodate the entered data, up to a maximum of 
40 inches. You can, however, set a fixed length for a label.  A different length can 
be set for each label in a file.

To change the length of the label:

1. Press .

2. Select Length>Fixed.

3. In the text entry box displayed, enter the desired length of the label.

Note: The unit of measure for the length is determined in the Setup menu. (See 
"Units” on page 1-45 for more information.)

4. Press Enter .
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Labels and Areas 
Go To Label or Area

To move to another label:

1. Press Label .

OR 

To move to another area on a multi-area label:

1. Press Area .

2. Select GoTo, then enter the number of the label or area to go to.

3. Press Enter .

Shortcut Using Keys

To go to the next label in the file:

1. Press Next Label .

To go to the previous label in the file:

1. Press Previous Label .

To move to the next area:

1. Press Next Area  .

To move to the previous area:

1. Press Previous Area  .
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Labels and Areas 
Shortcut Using Touch Screen

You can access different labels in a multi-label file or different areas on a multi-
area label using the scroll arrows on the screen.

To access the scroll arrows:

1. Touch Labels in the Header bar.

Four arrows display on the screen.

2. Touch the Down arrow to access the next label in the sequence.

3. Touch the Up arrow to access the previous label in the sequence.

If a label contains multiple areas:

4. Touch the Right arrow to access the next area in the sequence.

5. Touch the Left arrow to access the previous area in the sequence.

If you do not have multiple areas on a label, or multiple labels in a file, the arrows 
are grayed out. The arrows also gray out if you are on the first or last area or label.

Scroll arrows on multi-area, in multi-
label file.

Scroll arrows on single area, in multi-
label file
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Labels and Areas 
Delete Label or Area

Deleting a label removes all data and formatting on that particular label. If multiple 
areas exist on one label, when that label is deleted all the areas associated with 
that one label are also deleted. Deleting an area removes all data and formatting 
from that one area on one particular label. It does not delete that area on all 
labels.

To delete a label or area:

1. Navigate to the label or area you want to delete.

2. Press Label  if deleting a label OR press Area  if deleting 

an area.

3. Choose Delete.

A Delete Label or Delete Area confirmation message displays.

To delete the label or area, using the keyboard:

1. Press Enter  to confirm deletion.

2. Press Backspace  to cancel the delete function.

To delete the label or area, using the touch screen:

1. Touch  to confirm deletion.

2. Touch  to cancel the delete function.

Delete label confirmation Delete area confirmation
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Labels and Areas 
Justification

Justification refers to the alignment of data between boundaries (margins) on a 
label or in an area.  There are two types of justification:  horizontal and vertical. 
Horizontal justification (H. Justify) aligns data between the left and right 
boundaries of a label or area, while Vertical justification (V. Justify) aligns data 
between the top and bottom boundaries of a label or area.  Justification is applied 
to an area or a label.  It cannot be applied line-by-line.

Figure 3-8.  Justification examples

To apply justification:

1. Navigate to the label or area where justification is to be applied.

2. To apply justification to a label, press Label .

OR

To apply justification to an area, press Area .

3. Choose H. Justify or V. Justify.

4. Choose the horizontal or vertical justification desired.

Every line of data on the label or in an area is justified according to the option 
selected.  When adding a new label, the justification maintains the current 
justification settings, but you can change it again.  Different justification can be 
applied to individual labels in a multi-label file or different areas on one label.

Horizontal Justification Vertical Justification
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Labels and Areas 
Rotate

Rotation flips the data on a label or in an area, counter-clockwise, at 90° 
increments.  Rotation affects all data on a label or in an area.

Figure 3-9.  Degrees of rotation on printed label

Note: If rotation is applied individually to areas, you cannot apply rotation to the 
entire label. 

Data cannot be rotated on a line-by-line basis. When adding a new area or label, 
the rotation is the same as the previous area or label. 

To rotate data:

1. Navigate to the label or area where rotation will take affect.

2. To set rotation for the label, press Label .

OR

To set rotation for an area, press Area .

3. Choose Rotate>degree of rotation.

Rotated data is autosized to accommodate the height vs. the width of the label.  

Rotation does not display on the editing screen, although the degree of rotation is 
displayed in the upper left corner of the screen. To view the actual rotation, use 
Print Preview. (See "Print Preview” on page 5-2).
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Labels and Areas 
Frame

A frame (border) can be added to an area or a label, but not to a line of text. You 
can have a different frame, or no frame, on individual labels in a multi-label file. 
You can also place a frame on a label that contains area frames.

Note: Frames can only be placed on continuous labels, not die cut labels.

Figure 3-10.  Available frame options

1. To add a frame to a label, press Label .

OR

To add a frame to an area, press Area .

2. Choose Frame>frame type.  

Frames do not display on the editing screen. Use Print Preview (see page 5-2) to 
view the label or area frames.

Note: Frames do not display edge to edge, but may appear slightly offset from the 
very edge of the label.
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Labels and Areas 
To remove the Frame:

1. Navigate to the label or area that contains the Frame.

2. Press Label .

OR

Press Area .

3. Choose Frame>None.
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Labels and Areas 
Reverse

The Reverse function switches the foreground and background colors of data on a 
label, based on the color ribbon and media installed. 

Figure 3-11.  Reverse text

For instance, black lettering on a yellow background, if reversed, would print 
yellow lettering on a black background. 

You can apply Reverse formatting to areas or labels. When adding another area 
or label, the reverse function status carries over. Reverse cannot be applied to an 
individual line of text or to a barcode. 

To apply Reverse formatting to a label or area:

1. Press Label .

OR

Press Area .

2. Choose Reverse>ON.

The system formats the edge-to-edge data so that the foreground and background 
colors are switched.

To remove the Reverse function:

1. Navigate to the label or area displayed in Reverse.

2. Press Label .

OR

Press Area .

3. Choose Reverse>OFF.
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Labels and Areas 
Vertical Text

In Vertical text, each character drops down a line below the preceding character. 

Example: The word “WIRE” as vertical text displays as such:

W
I
R
E

Vertical text can only be applied to an area or a label.  It cannot be applied line-by-
line. 

To format text vertically:

1. Navigate to the label or area where you want to display text vertically.

2. Press Label .

OR

Press Area .

3. Choose Vertical>On.

The word(s) display vertically on the label or in the area.  

If more than one line of text is present, the second and subsequent lines of text 
display vertically to the right of the first line of text.

Note: The horizontal and/or vertical justification set before applying vertical 
formatting is carried over to the vertical lines of text.

Figure 3-12.  Multi-line vertical alignment

Multiple lines, before applying Vertical 
text (autosized)

Multiple lines, after applying Vertical 
text (autosized)
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Labels and Areas 
If a barcode is in the line of text to be placed vertically, or if the height of the label 
cannot accommodate the vertical placement of text, an error message displays. 

Note: See "Error Messages” on page 2-4 for information on clearing an error 
message from the screen.

The Editor then displays the text in its original format, without applying the vertical 
text option.

To remove the vertical text option, placing text in normal, horizontal format:

1. Navigate to the label or area displaying data as Vertical Text.

2. Press Label .

OR

Press Area .

3. Choose Vertical>OFF.

The text realigns according to predefined formats.
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Barcode
Barcode

A Barcode element represents a barcode graphic generated from user input. 
Barcodes are generated following industry standard symbology. A typical barcode 
is composed of vertical lines (bars) and spaces of varying thickness, depending 
on the text entered. It can also include “human readable text.” Human readable 
text is the data entered that makes up the barcode. Because you cannot read bars 
and spaces, you can have the actual text that makes up the barcode display.

Barcode elements support vertical resizing (height) only. The width of the barcode 
is based on data and symbology and cannot be changed. However, some 
barcode widths (depending on symbology used) can be altered by changing the 
ratio and density of the bar code. 

Barcode data can be displayed in the same line as other data (text or symbols). It 
is not necessary to have a separate area for the barcode. Barcode data on the 
same line as text will not overwrite the text already on the line but will be placed 
next to it. Any text in the same line as the barcode will align on the baseline with 
the barcode. 

Barcode Settings

Before entering a barcode, determine the barcode symbology and attributes to 
use.

Note: Additional barcode types can be supported by printing from PC software, 
such as LableMark™ 6.0.

To access the barcode settings:

1. Press Label .

2. Select Barcode.

3. Select the desired settings. (For information on how to work with dialog box 
fields and features, refer to Dialog Boxes, starting on page 1-37.)

4. When finished, select .
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Barcode
Field To Use

Barcode 
Symbology 

The BMP61 Label Printer supports Code 128 and Code 39 
barcode symbology. 

Ratio The ratio of a barcode is the relationship of narrow elements 
to wide elements, where elements are the bars and spaces. 
The ratios available are 2:1 and 3:1. 

Height The height of the bars in a barcode can vary, with a minimum 
of 0.1 inch (2.54 mm).

Width The width of the narrow bar of a barcode is 1, 2, or 3 dots.

Human Readable Human readable text is the data entered that makes up the 
barcode. Because you cannot read bars and spaces, you can 
display the actual text that makes up the barcode. Human 
Readable text can be placed above or below the barcode 
symbology, or you can choose to not display it.

Check Digit A check digit is used for error detection in a barcode. It 
consists of a single digit computed from the other digits in the 
barcode. A checkmark in the Check Digit option box turns the 
function on.
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Barcode
Add a Barcode

The barcode key acts as a toggle between a barcode and text. Press once to turn 
it on, press again to turn it off.

To add a barcode:

1. Position the cursor where you want to add the barcode.

2. Press Barcode .

3. Enter the barcode data.

The barcode displays on the screen as the data is being entered. 

Figure 3-13.  Barcode in line of text

When finished with the barcode entry, if you want to enter more data on the same 
line of text as the barcode:

1. Press Barcode  again.

This turns the Barcode mode off and returns to text mode. 

OR

When finished with the barcode entry, if you want to start a new line of text 
BELOW the barcode entry:

2. Press Enter .  

Pressing Enter moves the cursor to the next line, automatically turning off the 
Barcode function.
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Barcode
Edit Barcode Data

To edit barcode data:

1. Position the cursor in the barcode text.

The barcode mode automatically turns on.

2. Edit the barcode text.

The barcode mode automatically turns off when you move past the last character 
of the barcode.
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Serialization
Serialization

Serialization (or sequencing) automatically adds a series of sequential numbers or 
letters to the printed labels.  The Serial function consecutively places the next 
number or letter in the defined sequence on individual labels.  The number of 
labels created is defined by the sequence values you enter, and displays in the 
Header Bar. You can view the serialized labels before they print through the Print 
Preview function. (See "Print Preview” on page 5-2 for more information.) 

Serialization can be combined with other data on a label. Any data displayed on a 
label that includes serialization will be repeated on every label along with the 
serial data.

How Serialization Works

Serialization is alphanumeric, with numbers from 0 to 9, and letters A-Z. 
Serialization can be simple or linked, with a maximum of two sequences per label. 

Note: You can incorporate serialized data into a barcode

Serialization consists of a Start Value, End Value, and Increment. The Start Value 
is the number, letter, or combination of numbers and letters that begin the 
serialization sequence. The End Value is the termination point of the sequence. 

The Increment is the value that is added to the previous number in the sequence 
to produce the next sequence number. (You cannot have an increment value of 
0.) For instance, a start value of 1, an end value of 25, and an increment of 4 
would produce 1, 5, 9, 13, 17, 21, 25. 

Examples of Serialization

In a simple serialization, a sequence runs through its full range of numbers and/or 
letters (i.e., 0 to 9, or A to Z), one number/letter for each label. 

Example: Simple serialization: 

Sequence #1
Start Value:1
End Value:10
Increment:1
Produces:1, 2, 3, 4, 5, 6, 7, 8, 9, 10
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Serialization
You can combine letters and numbers in a single serialization. When the right-
most character in the Start Value reaches its maximum value (9, Z), the character 
immediately to the left is incremented, and the right character cycles back to its 
mimimum value (0, A)

Example: Combined, single serialization:  

Sequence #1
Start Value: A1
End Value: D4
Increment: 1
Produces: A1…A9, B0.. B9, C0.. C9, D0...D4

In a multi-sequence serialization, where the second set of values is NOT 
dependent on the first set (i.e., Linked box NOT checked), the two sequences 
increment sequentially, independent of each other. 

Example: Multiple serializations (where the second set of values is NOT 
dependent on the first set of values):

In a multi-sequence “linked” serialization (i.e., Linked box checked), the second 
set of values is dependent on the first set. The second sequence holds its initial 
value until the first sequece completes, after which it moves to the next value. 

Multiple linked serialization:

Sequence #1 Sequence #2

Start Value:  1 Start Value: A

End Value: 10 End Value: C

Increment: 1 Increment: 1

Produces: 1A, 2B, 3C, 4A, 5B, 6C, 7A, 8B, 9C, 10A

Sequence #1 Sequence #2

Start Value: 1 Start Value: A

End Value: 10 End Value: C

Increment: 1 Increment: 1

Produces: 1A..10A, 1B..10B, 1C..10C
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Serialization
Add Serialization

To add serialization to labels:

1. Position the cursor on the label where you want the serialization to display.

2. Press Serial .

A dialog box displays where you can enter the start value of the serialization, the 
end value, and the increment value.

For simple serialization:

3. With the cursor immediately displayed in the Start Value field of Sequence #1, 
enter the start value of the sequence.

If the start value is larger than the end value, the series will decrement 
automatically.

4. In the End Value field, enter the end value of the sequence.

5. In the Increment field, enter the increment value.

6. When ready, select .

For multiple serialization, displayed at different locations on the label:

7. Complete Steps 1 through 6 above.

8. On the Editing screen, navigate to the next sequence location (cursor 
position) on the label. (Skip this step if creating a compound serialization 
displaying at the same cursor position.)

9. Press Serial .
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Serialization
The previous serialization values display in the dialog box presented.

10. Navigate to the Add Seq 2 option box and press Enter .

11. In the Sequence #2 Start Value field, enter the start value for that sequence.

12. In the Sequence #2 End Value field, enter the end value for that sequence. 

13. In the Sequence #2 Increment field, enter the increment for that sequence.

For Linked serialization:

Note: Linked serializations do not have to display at the same position on the label. 
They can be in separate locations within the label.

14. Navigate to the Linked option box. 

15. Press Enter .

16. Navigate to the OK button and press Enter .

The total number of labels to be printed in the sequence displays in the Header 
Bar (i.e., Label # of ##). 
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Serialization
Edit a Sequence

You can change the serialization values after a sequence has been determined.  

To edit the sequence values:

1. Press Serial .

The Serial dialog box displays with the current values listed.

2. Select the value fields to change and enter the new value.

Note: If using multiple serialization at different positions on the label, be sure Add 
Seq 2 option box is checked.

3. When ready, select .
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List
List

The List function enables you to produce multiple labels with variable information 
from a single, formatted label (main document) and a structured data source. 

The data source (or database) is a collection of organized, related data. It is often 
set up in the form of a table, containing fields (columns) and records (rows). A field 
is one category of information for each record, while the record is the combination 
of all the field information for one label. 

When the merge is run, the system creates an output label for each record (row) in 
the data source.

Setting up the Data Source

The data source must be a .csv file created in a spreadsheet or database program 
on a PC and imported to the BMP61 printer via the USB port and a flash drive. 
You can also create the .csv file directly on the BMP61 printer. If you have created 
the .csv file on a PC, you must import the file to the printer before you can use the 
List function. (See "Using Files from an External Source” on page 4-11 for 
information on importing files using a flash drive.)

To create the data source directly on the BMP61 printer:

1. Press List .

2. Select Create.

3. Enter the number of fields (columns) the data source will contain.

4. Select Continue .
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List
The number of defined fields displays as blue and yellow squares at the top of the 
screen. The blue field is the current field. The gray square displays the record 
number as data is entered into the data source.

To select a field, using the keyboard:

5. Navigate to the field where you want to enter data and press Enter .

To select a field, using the Touch screen:

Double tap the field in which you want to enter data.

The data entry area of the selected field displays on the bottom half of the screen.

6. Enter the data for that particular field category, then press Enter .

7. Repeat Steps 5 and 6 for each field in which you want to enter data.

When you entered data in each defined field, another row automatically displays.

8. Select Next to move to the first field in the next row, then press Enter to 
access that field.

9. Repeat the above steps for each record of the data source.
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List
Working with Rows of Data

To move between the rows of data:

1. Select Next  to move foward through the rows of data.

2. Select Prev  to move backward throught the rows of data.

To insert a row between two rows of data:

1. Select a field in the row above which a row will be inserted. It makes no 
difference which field you select. 

2. Select Insert .

The row selected moves down and a new, blank row is inserted.

Figure 3-14.  Inserting a row in the database

To remove a row in the datasource:

1. Select a field in the row you want to delete.

2. Select Delete .
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List
Save the Data Source

To save the data source:

1. Select Save .

2. Enter a name for the data source, then press Enter . 

To exit out of the data source:

3. Press Backspace .

A message displays asking if you want to save the file before exiting. 

4. If you have already saved the file, select . The file remains saved.

5. If you have not yet saved the file, select . The printer will return to the 
Save function. Repeat Steps 2 through 4 to save the file.

Note: If you cannot recall if you saved the file, select . Then, if you see the 

file name in the list of files, select the name (to highlight it) and press Enter . A 

message indicates the file already exists. Select  to overwrite the file. This 

will ensure that your file has been saved. You are returned to the Editing screen.

6. Select  if you do not want to exit the database.
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List
Merging Files

Fields from the data source merge into specific areas defined on the label. 

To merge the data source with the label:

1. Create, or open, the label that will receive the data from the data source.

With the label in the Editing screen:

2. Press List .

3. Select Merge.

4. Select Internal or External to indicate where the data source file is stored.

5. Select the data source file.

If your label does not have the same number of defined areas as there are fields in 
the data source, the List function asks if you want to add additional areas.

6. Select Ignore  if you do not want to add additional areas.

The fields from the data source sequentially merge into the label, depending on 
how many areas are defined on the label. If you have four fields in the data source 
but only two areas defined on the label, the first two fields merge on to the label. 
The other fields are ignored and will not display on the label.

OR

7. Select Add  if you want the printer to define as many areas on the 

label as there are fields in the data source. Once the merge is complete, you 
can go back into the label and format the added areas.

The unique data in the data source file is merged to the label. Each field displays 
in a different area of one label. Each record (the collection of the fields) displays 
on a different label.
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List
Advanced Merge

You can create a data source to have many fields with varying information. 
However, you do not have to use every field on every label. For instance, even 
though the example database contains four fields (name, address, city-state, and 
customer number), you can create a label that uses only one or two of the fields. 
When you merge the data source with that label, you can indicate which specific 
fields you want to merge. This enables you to create one large data source file 
containing many fields of information that can be used with various label formats. 
You would not have to create a separate data source for each label format.

To merge only some fields in a database:

1. With the label open, press List  .

2. Select Adv Merge.

3. Select Internal or External to indicate where the data source file is stored.

4. Select the data source file.

The screen indicates how many fields are in on the particular label. It also lists 
how many fields are available in the data source. You can change which field in 
the data source you want to display in the areas of your label.

Figure 3-15.  Reordering columns in List merge

5. Select the Area field and enter the data source column number to use. 

6. Select .
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List
Edit Datasource

You do not have to enter all records into the data source at one time. You can 
continue to add more records to a saved data source as needed. 

To add more records to an existing data source:

1. Press List .

2. Select Edit.

3. Select Internal or External to indicate where the data source file is stored.

4. Select the data source file .

5. Enter field and record information as indicated on page 3-37. 

To edit data already in the data source:

1. Select the field to edit, then make the corrections according to normal editing 
procedures. (See "Editing Text” on page 2-1. )

2. When finished, save the data.
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4 File Management
Label Files

Figure 4-1.  File menu options 

A single label or a number of labels can be saved as a file, to be opened and reused at a 
later date.  The following are guidelines when creating a label file:

• Labels using continuous media or die-cut media cannot be combined in the same label file.  
All labels in a label file must use the same label part number.

• Serialized labels cannot be combined in a file with other non-serialized labels. 

Save

A saved file is held internally in the printer, even when the power is turned off.  The saved 
file retains the label data, data attributes, and alignment parameters.  This file is available 
for reuse whenever needed. 

File Naming Standards

To create a file on the BMP61 printer, the file must be given a name.  Names can be up to 
20 characters long and can consist of letters and numbers, no spaces. 

When creating files, remember this rule:  You cannot have two files with the same name.  
If you do, the most recent file with the name will overwrite the previous file with that name.  
A one-character difference in the name creates a different file and will not overwrite a 
previous file.
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Label Files
Internal vs. External

You can save labels as internal or external files. Internal files are labels stored 
directly on the BMP61 printer. External files are labels stored on some external 
device, such as a flash drive. 

To save labels:

1. Press File .

2. Select Save.

The memory location dialog box displays ONLY if an external source is attached 
to the printer. 

3. Select Internal to save directly to the printer.

OR

Select External to save to the attached external source.

Note: If no external device is attached, the above memory location dialog box does 
not display. 

<New Folder> displays in the text entry box. You can enter the file name directly 
over the <New Folder> moniker.

4. In the displayed text entry box, enter a name for the file.
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Label Files
5. Press Enter .

If the name already exists, a message displays asking if you want to overwrite the 
previous file with that name.  
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Label Files
Using the keyboard:

1. Press Enter  to overwrite.

OR

2. Press Backspace  to remove the message from the screen and 
return to the file name entry field. 

Using the Touch screen:

1. Touch  to overwrite.

2. Touch  to cancel the overwrite and return to the file name entry field.

When the file is saved, you are returned to the Editing screen with the saved file 
still displayed. If you want to remove the saved file from the screen, press Clear 

. (See "Clear” on page 2-3 for more information.) 
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Folders
Folders

To better organize your data, place similar label files into folders. Similar files 
could consist of all labels for a specific project, or all files that use the same 
media, or specific label applications, etc. 

To create a label file folder:

1. Press File .

2. Select Save.

3. With the <New Folder> moniker highlighted in the text entry box, press Enter 

.

OR
Double Tap <New Folder>.

4. Enter a name for the folder.

Note: For faster access of files, it is a good idea to assign a name that conveys the 
contents of the label file folder.

5. Select .
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Folders
To return to the list of folders:

1. Press Enter .

OR
Double Tap <Previous Folder>.
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Open a File
Open a File

To open (recall) a saved file:

1. Press File .

2. Choose Open.

A list of previously saved folders and files displays.  

To open a folder, using the keypad:

3. Navigate to the folder to open.

4. Press Enter .

5. Within the folder, navigate to the file to open, then press Enter .

To open a folder, using the touch screen:

6. Double Tap the folder.

7. Within the folder, Double Tap the file to open.
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Open a File
Only one file can be displayed on the screen at a time.  When opening a saved 
file, if the Editing screen contains other data, you are prompted to save the data 
before the screen is cleared. 

If you decide to save the displayed data, the Save function is invoked and you are 
allowed to give the data a file name before the requested file to open is displayed 
in the Editor.

When opening a file, if the stored data is incompatible with the installed media, an 
error message displays. 

While you do not have to use the exact label part number used when saving the 
file, you must use a part number that can accommodate the data in the file being 
opened.
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Delete a File
Delete a File

The Editor does not have to be cleared before deleting a file.  A file can be deleted 
with other data still on the screen. 

To delete a previously saved file:

1. Press File .

2. Select Delete.

3. Select the type of file you want to delete (graphics, list, or label).

A list of previously saved folders and files displays.  

4. Select the folder containing the file to delete (if applicable).

5. Select the file to delete.
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Delete a File
A delete confirmation message displays. 

6. Select  to confirm deletion.

OR

Select  to cancel the delete function.

If Yes is selected, the file is removed from the system and is no longer available 
for use.

Note: Folders are deleted the same way. However, you can only delete empty 
folders. If a folder contains files, you must first delete all the files within that folder 
before you can permanently remove the folder.
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Using Files from an External Source
Using Files from an External Source

You can use labels, .csv lists, or .bmp graphics created on a PC and stored on a 
flash drive. Labels can be imported (transferred) from a flash drive to reside on the 
BMP61 printer or you can open the label file directly from the flash drive. (Refer to 
"Internal vs. External” on page 4-2 for more information on labels stored on 
external devices.) Lists and graphics, however, must be imported to the printer 
before they can be used.

Import a File

To import a file created and stored on an external device:

1. Attach the external device to the BMP61 printer.

The Import menus will only display if the external device is attached.

2. Press File .

3. Select Import.

4. Select the file type you want to import (Label, List, or Graphics).

5. Using Folder and File navigation techniques (refer to opening a folder, starting 
on page 4-7), select the file you want to import from the external device.
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Using Files from an External Source
6. If importing a Label file, on the Select Destination screen, select the 
destination folder or storage area on the BMP61 printer where you want to 
store the imported file.

Label files can be stored in any folder on the printer. However, List files (.csv) and 
Graphic files (.bmp) are stored in specific folders used by the List and Graphics 
functions. These folders are unavailable to the user. When importing a list or a 
graphic, the destination screen does not display.

7. Press Enter to place the imported file in the selected folder.

Imported files retain the original file name the first time they are imported. If 
imported more than once, " - Copy [#]" is attached to the file name (where # is a 
number indicating how many times the file has been imported). This prevents a file 
from overwriting another file with the same name.

You can open an imported Label file through the File/Open function (see page 4-7)

List (.csv) files can be opened through the Merge feature of the List function.

Graphics (.bmp) files can be viewed and accessed through the Graphics function.
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Using Files from an External Source
Export a File

Files created on the BMP61 printer, or previously imported from an external 
device can, in turn, be exported back to an external device.

To export a file currently on the BMP61 printer to an external device:

1. First, attach the external device to the BMP61 printer (to ensure the 
Import/Export menus display).

2. Press File .

3. Select Export.

4. Select the file type you want to export (Label, List, or Graphic).

5. Using Folder and File navigation techniques, select the file you want to export 
to the external device.

6. On the Select Destination screen, using folder navigation techniques, select 
the destination folder or storage area where you want to store the exported 
file on the external device.

7. Enter the name for the file to export, then press Enter  to export the file.
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5 Printing Labels
Print

The Print function prints the current file. 

To print:

1. Press Print .

The data is printed and the status of the 
print job is reflected in the Status Bar 
(e.g., Printing 1 of 10). 

After printing, to cut the label: 

2. Pull the cutter lever forward (towards 
you) as far as it will go.

Printing from the BMP61 printer occurs in 
the background, meaning you can 
continue to edit or create new labels while 
the file is printing. 

If a print job is interrupted, for instance 
when media or ribbon runs out, or you 
intentionally open the cover, the system 
automatically stops the print job and 
displays a message. While the message remains on the screen, follow the instructions on 
the display to resume printing.
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Print
Print Preview

The Print Preview function of the BMP61 printer enables you to view your label file 
prior to printing. 

To preview the label:

1. Press Preview .

OR
Double Tap the data in the Editor screen.

The label contents display.

To print directly from Print Preview:

2. Press Print .

To exit Print Preview and return to the editing screen:

1. Press Backspace .

OR
Tap the print preview screen.

You are returned to the editing screen.
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Print
Scrolling in Print Preview

If a label file is particularly long it may not be completely visible on one screen in 
print preview. The Print Preview screen displays left/right or up/down scroll bars 
indicating there is more data to view. 

To scroll through a preview of a long label or multiple labels:

1. Press up/down navigation keys, as applicable. 

OR

On the touch screen, drag your finger in the direction you want to move.
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Multiple Print
Multiple Print

Multiple print lets you print multiple copies of a label or series of labels.

To print a number of copies:

1. Press Multi .

2. With the cursor in the No. of Copies field, enter the number of copies desired.

Collate

To get multiple copies of a serialization, first determine if the sequence should be 
collated or non-collated. 

Collated – All sequential numbers will print once, then the entire sequence prints 
again.

Example: Collate three copies of Sequence 1-5
Produces 1,2,3,4,5; 1,2,3,4,5; 1,2,3,4,5
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Multiple Print
Non-collated – Prints all first numbers in a sequence, then all second numbers, 
etc.  

Example: Print three copies of sequence 1-5, non-collated
Produces:  1,1,1; 2,2,2; 3,3,3; 4,4,4; 5,5,5.

The default is to print collated. If you do not want to collate the copies:

3. Select the Collate option box to remove the checkmark.

When printing (or re-printing) a single label in a series, or a range of labels in a 
series, use the Print Range feature. 

4. Under Print Range, select From field and enter the number of the first label to 
be printed.

5. Select To field and enter the number of the last label to be printed..

Separator 

To separate different labels on continuous media, add a separator.

Figure 5-1.  Separators

6. Select the desired separator from the drop down list.

Line Separator Tic Separator
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Mirrored Print
Mirrored Print

Mirrored print takes all data on a label and flips it to provide a mirror image. 
Mirroring displays on the printed label only.

Figure 5-2.  Mirror image

Mirrored print is label-based, meaning all data on the label is mirrored. You cannot 
mirror data in an individual area. 

To provide a mirror image of label contents:

7. In Multiple Print dialog box, select Mirrored Print to place a checkmark in the 
option box.

8. When finished with all options, select .
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Print History
Print History

Print History is a convenient feature that enables easy access to recently used 
files. It keeps track of the last 10 label files printed. 

To access Print History:

1. Press Print History .

OR
Touch the Header or Status bar, then select Print History.

A list of previously printed files displays at the bottom of the print screen. You can 
reprint any of these files. 

2. Select the file you want to print.

3. Press Print .
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If the file you want to reprint is incompatible with the currently installed media, a 
message displays indicating such. 

4. To correct, install the media indicated in the error message.

5. Clear the message, then press Print .



6 Label Types
Label Types

Label types provide templates that guide and control the layout for label formats and may 
require specific media. The label types available are:

• General

• Wire Marker

• Flags

• Terminal Block

• Patch Panel

• 66 Block

• 110 Block (or BIX Block)

• Vial

• DesiStrip

• Breaker Box

Figure 6-1.  Label Types 
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General
General

The General label type contains standard functions and formats used for most 
generic labels. However, all other label types provide templates that guide and 
control the layout for the specific application. 

Depending on the application chosen, a sub-menu or dialog box displays to collect 
information for automatically formatting the specific label type.

The name of the specific label type being used is displayed in the Header bar 
below the media indicator.
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WireMarker
WireMarker

The WireMarker label type is designed to repeat entered data down the length of 
the label. The data repeats as many times as possible, considering the font size 
and the wire size selected.

Figure 6-2.  Repeated data on a WireMarker or Cable Marker label

Die-cut, self-laminating, or continuous media can be used for WireMarker labels. 

To use the WireMarker application:

1. Press Label Type .

2. Select WireMarker.

3. Select the wiremarker gauge and length.

Note: The label size is fixed by the gauge and size selected in the sub-menu, even 
if using continuous media.

4. Enter the data.
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WireMarker
The data is repeated down the wiremarker label as many times as the length of 
the label allows and the font size used. The smaller the font size, the more the 
data is repeated.

If you press [Enter] to start a new line of text, a space opens below each line of 
repeated data and begins to repeat the next line of text as you enter it. 

Figure 6-3.  WireMarker label with multiple lines
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Flags

A Flag label wraps around a wire or cable, with the ends joined together to form a 
flag. The Flag application is designed to work with continuous media or specific 
multi-area die cut labels.

To use a Flag label type:

1. Press Label Type .

2. Select Flags.

A dialog box displays the different Flag layouts, preceded by a radio button. (For a 
review of dialog box navigation, see "Dialog Boxes” on page 1-37.)

To configure a flag layout:

1. Select the radio button of the desired layout.

2. If continuous media is installed, in the Flag Length field, enter the length of the 
flag (the part that contains the text).
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Flags
Figure 6-4.  Flag length vs. diameter

3. In the Cable Diameter field, enter the diameter of the wire/cable to which the 
flag will be applied.

The range for the cable diameter is 0.25 inches to 8 inches. By entering the 
diameter of the wire or cable, the system automatically calculates an additional 
length of label to allow complete wrap of the wire/cable with additional label 
material left for the flag.

If Rotate is selected, each element of the text layout in the selected template (Text 
1, Text 2) rotates 90 degrees left or right from it original position.

Figure 6-5.  Flag template layouts when rotation is applied

Flag Template 
Text Layout

Text Layout with 
rotation applied
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Flags
4. To rotate data, select Rotate to place a checkmark in the option box.

5. When finished, select .

6. On the Editing screen, enter the text that will display on the flag. 

Rotation is embedded in the template design, based on the flag design you pick. 
Justification is defaulted to center, middle. The font size remains whatever size is 
set when the flag label type is chosen.

If the design chosen indicates only one text element, the printer automatically 
duplicates the entered text for the other area, rotating according to the predefined 
layout. 

In a 2-text element flag layout, you enter text in two separate areas. The areas are 
designated in the Header bar. Use the Next Area and Prev Area keys to move to 
the different areas.  The Header bar indicates which area you are in. (See "Labels 
and Areas ” on page 3-13 to review working with multiple areas and labels.)

Use Preview to view the labels before printing.
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Terminal Block, 66 Block, Patch Panel
Terminal Block, 66 Block, Patch Panel

Terminal Block, 66-Block, and Patch Panel applications are designed to be used 
with continuous media.  If no continuous media is installed, these applications do 
not display in the menu. 

To use a Terminal Block, 66-Block, or Patch Panel label type:

1. Press Label Type .

2. Select Terminal Block, 66 Block, or Patch Panel.

A dialog box displays requesting additional information. (For a review of dialog box 
navigation, see "Dialog Boxes” on page 1-37.)

3. In the Terminal Repeat field, indicate the size of the gap between each 
terminal (with a minimum of 0.2 inches). 

4. In the Number of Terminals field, enter the number of terminals on the block 
for which the label is intended. 
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Terminal Block, 66 Block, Patch Panel
If you intend to use serialization for the Terminal Block, 66-Block, or Patch Panel 
label type, you do not need to enter the Number of Terminals. The serialization 
values determine how many labels to create. 

5. To serialize data, select Serialize to place a checkmark in the option box.

Once Serialize is selected, the Number of Terminals field grays out, making it 
inaccessible to enter data.

6. In the Separator field, from the drop down list, select the separator to use. 

Figure 6-6.  Separators and Orientation

7. In the Orientation field, from the drop down list, select the desired layout.

8. When finished, select .

If the Serialize option box is checked, the Serial dialog box displays.

Line Separator, Vertical Orientation Tic Separator, Horizontal Orientation
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Terminal Block, 66 Block, Patch Panel
9. Complete the Serialization. (See "Add Serialization” on page 3-33 for more 
information.) 

10. When finished, select .

The number of terminal blocks are created as labels, with the serialization 
characters displayed on each label. 

If serialization was not used, on the Editing screen, enter unique data for each 
label. 

Use Preview to view the labels before printing.
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110-Block, Bix Block Label Type
110-Block, Bix Block Label Type

The 110-Block and Bix Block use only the following dedicated label parts. 

• 110-Block: M61C-475-412 or M61C-475-422

• Bix Block: M61C-625-412 or M61C-625-422

The 110-Block label type is based on user-selected pair configurations, with the 
length of the label determined by the pair type selected.  The label height uses a 
dedicated 110-Block part height of 0.475 inch. The length of a 110-Block label is 
7.5 inches, with a total strip length of 7.9 inches. The number and formatting of 
areas is based on pair configuration and serialization selected. 

Bix Block template information is similar to the 110-block, with some variations on 
height and length of strip. The label height uses a dedicated Bix Block part height 
of 0.625 inch. The length of a Bix Block label is 6.2 inches with a total strip length 
of 6.6 inches.

To use the 110- or Bix Block application:

1. Press Label Type .

2. Select 110-Block or BIX Block.

A dialog box displays requesting further information. (For a review of dialog box 
navigation, see page 1-37.)
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110-Block, Bix Block Label Type
In the 110- and Bix Block applications, the number of areas created is based on 
the pair configuration selected. Vertical and horizontal separator lines are 
automatically added.

The following example displays the areas based on the Block Type selected (i.e., 
2-pair, 3-pair, 4-pair, 5-pair, or blank). The “Blank” strip is formatted as two areas 
covering the full printable length of the strip.

Figure 6-7.  Sample pair configurations

3. In the Block Type field, from the drop down list, select the pair configuration to 
use.

Sequence Type is used to determine how, and if, you want to serialize data. If 
None is selected, the areas are blank and you can independently enter data in 
each area of the strip. Horizontal increments one number per area, based on the 
start value. 
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110-Block, Bix Block Label Type
In Backbone serialization, the left-most area on each strip prints with two 
numbers. The first number is left-justified; the second number is right justified. All 
other areas print with one right-justified number. 

Figure 6-8.  Sample seqeunce types 

4. In the Sequence Type field, from the drop down list, select the Sequence Type 
to use.

5. In the Start Value field (except when “None” is selected in the Sequence Type 
field), enter the first number of the sequence.

6. In the # of Strips field, enter the number of strips (labels) to be created in the 
block configuration chosen. 

Note: If serializing the data, additional strips will continue the serialization from the 
last number of the previous strip. Example: When requesting two strips of a 4-pair 
configuration, the first strip will contain values 1-12, the second strip will contain 
numbers 13-24.

7. When finished, select .
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Vial
Vial

The Vial label type can be used with any media except SelfLam or Permasleeve. 
(If SelfLam or Permasleeve media is installed, the Vial label type does not 
display.) The Vial label type fixes the length of the label based on the vial size 
selected and formats the data horizontally or vertically. 

To create a label using the Vial label type:

1. Press Label Type .

2. Select Vial, then select the vial size.

3. Enter the data to display on the vial label.

1. .

Landscape (horizontal on printed label) Portrait (vertical on printed label)
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DesiStrip
DesiStrip

A DesiStrip (Designation Strip) is a paper faceplate label that can rest over the 
keys of a phone or switches in a breaker box, etc.

Figure 6-9.  Example of DesiStrip labels

To create a DesiStrip:

1. Press Label Type .

2. Select DesiStrip.

3. In the Length field, enter the length of an individual strip.

4. Select .
BMP®61 Label Printer User’s Manual 6-15



Breaker Box
Breaker Box

Breakers are usually arranged in two columns or along one row, depending on 
geographic regions. The breaker positions are numbered left-to-right or top-to-
bottom, depending on label orientation. This numbering system is universal across 
various competing manufacturers of breaker panels. 

To create Breaker Box labels:

1. Press Label Type .

2. Select Breaker Box.

A dialog box displays. (For a review of dialog box navigation, see "Dialog Boxes” 
on page 1-37.)

3. In the Breaker Repeat: field, enter the width of a standard breaker.

4. In the Number of Breakers: field, enter the number of breakers to be labeled.

This produces one continuous strip, separated by the Breaker Repeat width, 
vertically aligned for US breaker boxes, or horizontally aligned for EU breaker 
boxes.

The BMP61 firmware also includes the pole count to calculate the distance 
between breakers to ensure accurate spacing. A single-pole breaker takes up only 
one space in the electrical panel, while a double-pole takes up two.

5. If the breakers contain different pole counts, select Variable Pole Count to 
place a checkmark in the option box.
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Breaker Box
6. In the Separator field, from the drop down list, select the separator to use.

Figure 6-10.  Separators and orientation

7. In the Orientation field, from the drop down list, select the orientation to use. 

8. When finished, select .

If Variable Pole Count is selected, the Breaker Box Pole count dialog displays. 
The number of poles for each breaker defaults to 1.

9. Select the Breaker number field to change and enter the appropriate number.

10. When finished, select .

11. On the Editing screen, enter the unique data that will display on the label for 
each breaker. 

Line Separator, Vertical Orientation Tic Separator, Horizontal Orientation
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Breaker Box
Each breaker is consigned to a single label, the number of labels designated by 
the number of breakers defined. The number of labels display in the Header bar. 
Use the Next Label and Prev Label keys to move to the different labels.  The 
Header bar indicates which label you are on.

Use Preview to view the labels before printing.

Figure 6-11.  Breaker Box label strip

Number of labels created by 
number of breakers defined.

Breaker Box label 
printout.
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7 Maintenance and Troubleshooting
Cleaning the Printer
Cleaning the printer will improve print quality and legibility. It also increases output, 
machine life, printer reliability and performance.

Display Screen

To clean the display screen:

1. Lightly moisten a soft (non-scratching) cloth with isopropyl alcohol.

OR

Use pre-moistened static-free cloths available with the Brady PCK-6 Cleaning Kit.

2. Gently wipe the display screen until clean.
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Cleaning the Printer
Internal Components
Internal Components

Use a Brady BMP61 disposable cleaning card (purchased separately) to safely 
and effectively remove all dirt, ribbon ink residue, adhesive, and other 
contaminants from the thermal print head, platen roller, and paper path.

Note: Remove the ribbon and label spool before initiating the cleaning routine.

To clean the printer, with the printer turned on:

1. From the Setup menu, select Config.

2. Select Clean Printer.

3. Follow the instructions on the screen.

4. With the ribbon removed, close the printhead lock lever.

5. Set the printer media guide to the widest position.

6. Insert the cleaning card into the label path until it stops against the printhead 
and platen roller.

7. Press Enter  to initiate the cleaning routine.

8. After cleaning is complete, remove printer cleaning card and dispose of 
properly.

Note: Allow 15 seconds for the print head, platen roller, and label path to dry before 
reloading labels and ribbon. 
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Replacing the Cutter Blade Cover
Internal Components
Replacing the Cutter Blade Cover
If the printer is accidently dropped, the cutter blade cover may come lose or fall 
out. If the blade cover is not dented or damaged in some other way, you can 
easily re-insert the blade cover into the printer. 

To re-insert the cutter blade cover:

1. Grasp the blade cover from the top with the cut-out portion of the blade facing 
the display screen (away from the media well).

2. Pull the black flap forward, then insert the blade tight up against the black flap 
with the metal tabs fitting over the outside of the cutter housing.
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Replacing the Cutter Blade Cover
Internal Components
The blade cover snaps in easily.

To remove the cutter blade cover:

1. From inside the media well, slip your finger under the right side of the blade 
cover and gently pull up to unhook the blade cover.

The blade cover releases easily.
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Replacing the Printer (Media Well) Cover
Internal Components
Replacing the Printer (Media Well) Cover

If the printer is accidently dropped, the media well cover may come off. If the 
cover is not damaged, it can easily be re-attached to the printer.

To re-attach the printer media well cover:

1. Insert the cover locking tab on one side of the printer cover with its 
corresponding locking groove on the printer.

2. Gently squeeze the other side of the media cover enough so its locking tab 
can slip into the other locking groove of the printer.

3. Push down to snap the cover into place.
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Replacing the Printer (Media Well) Cover
Internal Components
Troubleshooting
Use the following table to troubleshoot and diagnose possible performance problems with your BMP®61 Label 
Printer. If the corrective action suggested does not work, contact Brady’s Technical Support Group.

Problem Cause Corrective Action

Hardware

Head over temp Print Head too hot Printhead has reached maximum 
operating temperature. Let 
printhead cool down for 
approximately 10 minutes, then 
re-initiate print job.

Keyboard works intermittenly or 
not at all.

One or more keys is stuck in 
depressed state.

Identify any keys stuck in down 
position. Repress key to unstick.

Error - "Cover not closed" Cover not closed. (Printer has a 
sensor that indicates when the 
printer cover is fully latched.)

Push down firmly on cover till 
you hear it latch. It should line up 
evenly with printer case. 

Cutter does not cut. Possible adhesive buildup. Clean the cutter blades with a 
moistened swab from the cleaning 
kit. (See page 7-1 for more 
information on cleaning the 
printer.)

Power ON/OFF (Printer not working)

Printer does not power up when 
turned on. 

Battery pack is not charged. Attach the AC Adapter to the 
printer and plug into an electrical 
outlet. This will supply immediate 
power while charging the battery 
at the same time.

Screen freezes User interface error. 1. Press Power button to turn the 
printer off.

If Power button does not shut 
down printer:

2. Remove the AC adapter (if 
using one).

3. Remove the battery pack, then 
immediately re-insert.

4. Power ON the printer.
7-6 BMP®61 Label Printer User’s Manual



Replacing the Printer (Media Well) Cover
Internal Components
Power ON/OFF (Printer not working) (continued)

Printer frequently powers OFF. Battery is low. Attach the AC Adapter to the 
printer and plug into an electrical 
outlet. This will supply immediate 
power while charging the battery 
at the same time.

Printer frequently powers OFF. Auto shutoff timing. Adjust the Shut Off Delay timing 
in the Setup>Config menu. (See 
page 1-45.)

Printer not responding Battery is dead. Attach the AC adapter to provide 
power to the printer and charge the 
battery.

OR

Install a new battery.

Error while printing Printer cover was opened during 
printing/feeding function.

1. Reinstall ribbon and 
label/media. 

2. Press [CLEAR/ESC] key to 
clear error. 

Print Quality

Poor quality printing Incorrect label material/ribbon 
combination.

Verify the correct ribbon for the 
label roll is loaded in the printer. 
Refer to the Ribbon Cross 
Reference Guide (Appendix B) 
for the proper ribbon selection.

Poor quality printing Battery pack may be worn out and 
not properly holding a charge.

Battery life is approximately one 
to three years, depending on its 
use and care. Order a replacement 
battery pack. 

Poor print quality. Ribbon and label media are 
incompatible.

Change the ribbon or label 
combination. (See Appendix B for 
a list of compatible media.)

Poor print quality. Ribbon or label media are 
installed incorrectly.

Review the instructions for 
loading the ribbon (page 1-14) or 
loading media (page 1-16).

Poor print quality. Dust or adhesives accumulated on 
the print head.

Clean the print head. (Refer to 
page 7-1 for instructions on 
cleaning the printer.)

Problem Cause Corrective Action
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Replacing the Printer (Media Well) Cover
Internal Components
Print Quality (continued)

No print on the label The label or ribbon is not loaded 
correctly.

Review the instructions for 
loading the ribbon (page 1-14) or 
loading the media (page 1-16).

No print on the label Out of ribbon. Load a new ribbon.

Void areas or lines appear on 
printed text.

Ribbon wrinkling. • With the ribbon installed, 
tension the ribbon by rotating 
the rewind spool (top spool) in a 
downward direction until all 
slack is removed. (See page 1-
13 for more information.)

• Try another ribbon cartridge.

Faint print on labels. Ribbon not advancing properly. • With the ribbon installed, 
tension the ribbon by rotating 
the rewind spool (top spool) in a 
downward direction until all 
slack is removed. (See page 1-
15 for more information.)

• Try another ribbon cartridge.

Ribbon

Error - "No ribbon installed" No ribbon installed or ribbon 
installed incorrectly.

1. Press [CLEAR/ESC] key to 
continue editing. 

2. Ensure ribbon is installed 
correctly before printing. (See 
page 1-14 for proper 
installation.)

Error - "No ribbon installed" Damaged circuit board (memory 
device) on ribbon cartridge.

Replace ribbon cartridge.

Error - "No ribbon installed" Damaged contacts on printer for 
reading ribbon cartridge.

Send to Brady for repair.

Error - "Out of ribbon" Ribbon supply has run out. 1. Replace ribbon cartridge.  

2. Press [CLEAR/ESC] key to 
clear error

Problem Cause Corrective Action
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Replacing the Printer (Media Well) Cover
Internal Components
Ribbon (continued)

Error - "Out of ribbon" Ribbon cartridge has excessive 
slack between the supply spool 
and rewind spool. The printer 
utilizes a sensor to verify that the 
ribbon supply spool is turning 
during feeding or printing 
operations.  Excessive slack will 
cause supply spool to not turn and 
therefore a premature "out of 
ribbon" error.

1. With the ribbon installed, 
tension the ribbon by rotating 
the rewind spool (top spool) in 
a downward direction until all 
slack is removed. 

2. Press [CLEAR/ESC] key to 
clear error

(Refer to page 1-14 for proper 
ribbon installation.)

Error - "Out of ribbon" Ribbon is broken.  Ribbon can 
break by (1) reprinting over an 
area of the ribbon that has already 
been printed or (2) damage in 
handling.

1. Replace ribbon cartridge. 

2. Press [CLEAR/ESC] key to 
clear error

Error - "Out of ribbon" Label or ribbon jam during 
feeding/printing

1. Clear any jams by opening the 
printer cover and removing an 
excess labels in the feed roller 
or exit chute areas.  

2. Press [CLEAR/ESC] key to 
clear error

Error - "Out of ribbon" Ribbon cartridge memory device 
has counted down to zero.  Circuit 
board on ribbon cartridge contains 
a memory device that tells the 
printer how much unused ribbon 
remains in the ribbon cartridge.

1. Replace ribbon cartridge  

2. Press [CLEAR/ESC] key to 
clear error.

Error - "Label and ribbon color 
are identical"

Ribbon color and label color are 
the same.  Printing will not be 
visible.

1. Replace ribbon or 
label/media.  

2. Press [CLEAR/ESC] key to 
clear error. 

Error - "Ribbon not optimized for 
label type"

Ribbon material type and label 
material type that are installed in 
the printer may not be compatible.  
Poor printing or poor ink 
adherence to labels may result 

1. Replace ribbon or 
label/media. 

2. Press [CLEAR/ESC] key to 
clear error. 

Problem Cause Corrective Action
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Replacing the Printer (Media Well) Cover
Internal Components
Labels (Media)

Printer will not feed labels. The leading edge of the label roll 
is not inserted up to the black line 
under the ribs.

Make sure the leading edge of the 
label roll is securely under the ribs 
(at least up to the black line).

Printer will not feed labels. The leading edge of the label roll 
is uneven or torn (not a straight 
edge).

Use a pair of scissors to cut a 
straight leading edge on the label 
roll.

Label material jams in printer. Last label was not removed. Make sure the last cut label has 
been removed from the label tray.

Error - "Out of Media" Label/Media supply is exhausted 1. Replace label/media roll.  

2. Press [CLEAR/ESC] key to 
clear error

Error - "Out of Media" Labels/media are not installed 
correctly.  Labels/media must be 
installed so that they are biased 
against the front wall of the lower 
printer base.  Notch Sensors in the 
lower printer base need to detect 
the prescence of the labels to 
allow printer to operate correctly.

1. Reinstall labels/media. 

2. Press [CLEAR/ESC] key to 
clear error.  

(See page 1-16 for proper 
label/media loading.)

Error - "Out of Media" Notch sensors in lower printer 
frame are dirty.  Notch Sensors in 
the lower printer base need to 
detect the prescence of the labels 
to allow printer to operate 
correctly.

1. Clean sensors in lower printer 
base. Press [CLEAR/ESC] 
key to clear error.  

(See page 7-1 for proper cleaning 
techniques.)

Error - "Out of Media" Label/media memory device has 
counted down to zero.  Circuit 
board on the roll holder core of 
label/media contains a memory 
device that tells the printer how 
much unused material remains on 
the label/media supply.  Reuse of 
the roll holder with memory 
device will eventually count down 
to zero and give error

1. Replace label/media or 
label/media roll holder.  

2. Press [CLEAR/ESC] key to 
clear error. 

Problem Cause Corrective Action
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Replacing the Printer (Media Well) Cover
Internal Components
Labels (Media) (continued)

Error - "No media installed" BMP61 labels/media are not 
installed correctly. 

1. Reinstall labels/media.  

2. Press [CLEAR/ESC] key to 
clear error.  

See page 1-16 for proper 
label/media loading.  Verify that 
circuit board on core of labels are 
mating with contacts in receiver 
slot of lower printer base. 

Error - "No media installed" Damaged circuit board on 
label/media roll

1. Replace label/media roll. 

2. Press [CLEAR/ESC] key to 
clear error

Error - "No media installed" Damaged contacts in receiver slot 
of lower printer base.

Send to Brady for Repair

Error - "Top of form" Label/media or ribbon has caused 
jam

1. Clear any jams by opening the 
printer cover and removing 
any excess labels in the feed 
roller or exit chute areas. 

2. Press [CLEAR/ESC] key to 
clear error. 

Error - "Top of form" Notch sensors in lower printer 
frame are dirty.  Notch Sensors in 
the lower printer base need to 
detect the prescence of the labels 
to allow printer to operate 
correctly.

1. Clean sensors in lower printer 
base.  

2. Press [CLEAR/ESC] key to 
clear error.  

(See page 7-1 for proper cleaning 
techniques.)

Error - "Label and ribbon color 
are identical"

Ribbon color and label color are 
the same.  Printing will not be 
visible.

1. Replace ribbon or 
label/media.  

2. Press [CLEAR/ESC] key to 
clear error. 

Problem Cause Corrective Action
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Internal Components
Program

File incompatible with installed 
media

A saved file (or power off file) 
was designed for media not 
currently installed.

Install correct media.

Incompatible Media for chosen 
application

The labels installed cannot 
accommodate the application 
requirements. (E.g., attempting to 
run a 110-Block application on 
die cut media.)

Install correct media.

Invalid terminal repeat value 
entered.

The value entered is out of the 
range.

The acceptable range is between 
the minimum of 0.2 inch to the 
maximum of 40 inches.

No applications available Applications not selected Ensure that the desired 
applications are activated.

1. Press Setup.

2. Choose Apps.

3. Navigate to the desired 
applications and press [OK] 
to place a checkmark in front 
of each application.

4. Navigate to the OK button 
and press [OK].

Problem Cause Corrective Action
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A Keyboard Configurations
Languages on Keyboards

Your keyboard configuration depends on the region where you do business. The following 
are the currently supported keyboard configurations. 

There are four keypad configurations available for the BMP®61 Label Printer. The keypad 
layouts and the language supported by each are as follows: 

Keyboard Type Language Applied

 QWERTY English, Latin American Spanish, French Canadian, 
Brazilian Portuguese, Danish, Finnish, Italian, Dutch, 
Norwegian, Polish, Portuguese, Romanian, Spanish, 
Swedish

AZERTY English, French, Dutch

QWERTZ English, Czech, German, Hungarian, Slovakian, 
Slovenian, French, Italian

Cyrillic English, Bulgarian, Russian
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Languages on Keyboards
QWERTY
QWERTY
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Languages on Keyboards
QWERTZ
QWERTZ
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Languages on Keyboards
AZERTY
AZERTY
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Languages on Keyboards
CYRILLIC
CYRILLIC
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1 Symbols
Symbols for all enabled applications are available for use on any label, regardless of the application/label type in use. 
See page 3-8 for information on how to apply symbols to your labels.
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Arrows DataComm
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Electrical Exit

Fire

First Aid
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CLP/GHS

Home Electrical

Greek

HSID

International
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Laboratory Laboratory (cont.)
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Mandatory Misc

Packaging

PPE
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Prohibition Public Info

Safety
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Warning WHMIS
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	1 Introduction
	Description

	The BMP®61 Label Printer is capable of printing on a variety of both die-cut and continuous supplies. It includes the following features:
	Unpack Your Printer

	The following items are included in the standard BMP®61 package:
	Accessories

	The following items are accessories available for the BMP®61 Label Printer and can be purchased separately from your distributor:
	Save Your Packaging

	The packaging surrounding your BMP®61 printer should be saved in the event you have to ship the printer and accessories back to the supplier.
	Register Your Printer

	Register your printer on-line at www.bradycorp.com/register and receive free product support and updates!
	BMP®61 System Specifications

	The BMP®61 printer has the following specifications:
	Physical and Environmental Characteristics

	The BMP®61 printer has the following physical and environmental characteristics:
	External View
	Power Source

	Power is supplied to the BMP®61 printer from a BMP41-BATT NiMH battery pack, or from an AC power adapter.
	Loading the BMP41-BATT NiMH Battery Pack
	2. With the battery label facing outward, insert the battery pegs into the peg slots at the top of the compartment; then tip the battery downward into place.
	3. Re-insert the battery door tabs at the base of the compartment and swing the battery compartment door closed, snapping it into place.

	AC Power Adapter

	The printer can be powered through an AC/DC power adapter. When the adapter is plugged in, it is also charging the BMP41-BATT NiMH battery (if installed).
	Brady AC Adapters
	Attaching the Adapter
	2. Plug the female end of the electrical cord into the opposite side of the adapter. Plug the male end of the electrical cord into an electrical outlet.

	Quick Charger

	The battery quick charger is an accessory that can be purchased through your BMP61 distributor. While the battery is charged from inside the printer when the AC adapter is attached, there may be times when you want to have another battery fully charg...
	2. Plug the female end of the electrical cord into the opposite side of the adapter. Plug the male end of the electrical cord into an electrical outlet.
	3. Insert the battery into the charger with the label facing toward the front of the charger.
	Connecting

	The BMP®61 Label Printer is equipped with a USB port to connect to a computer and a USB host port to be used with a flash drive. Labels created in various applications (such as LabelMark™ Labeling Software or Brady Mobile Software) can be printed ...
	Connecting to a PC

	In order to send data from a Brady PC labeling program to the BMP®61 printer, you must install the BMP®61 printer driver. The printer drivers can be found on the Product CD enclosed with your BMP®61 printer package.
	1. Insert the Printer Drivers CD into the CD drive of your computer.
	2. Run Setup.exe, then follow the prompts on the screen.
	3. When prompted by the installer program, attach the small end of the USB cable to the printer, then the flat end of the cable to the PC.
	4. Turn the printer on.

	On the PC, “Found New Hardware” pops up in the lower right corner of the screen and the printer driver wizard is launched.
	5. Follow the prompts in the printer driver wizard.
	Download Print Drivers

	You can also download the print drivers from the Brady website, such as www.bradyid.com, or your local site. On the website, choose Technical Support>Downloads, then follow the instructions on the screen.
	Pause/Cut Preference

	After the printer driver is installed, access the printer and set the Pause/Cut preference.
	1. In Windows XP, click Start, then choose Settings>Printers and Faxes. OR In Windows 7, click Start, then choose Devices & Printers. OR In Windows 8 or Windows 10, using the Search feature in the Charms bar, search for Devices and Printers.
	2. In the list of available printers, right click BMP61 and choose Printing Preferences.

	The Layout tab of Printing Preferences displays.
	3. Click button.
	4. On the Advanced Options screen, click Properties button for Custom Settings.
	5. On the Custom Settings screen, click the down arrow in Cutter Option field and select if you want to pause the printer for cutting at the end of each label or at the end of the job.
	6. Click OK to accept the changes. (You may have to click OK a number of times as you back out of the Printing Preferences screens.)
	Wireless Driver Installation

	You can determine if your printer supports WiFi communication by checking for the "WiFi-installed" label on the inside of the printer cover. The Wireless drivers and driver installation instructions can be found on the Brady Printer Drivers CD.
	1. Insert the Brady Printer Drivers CD into the CD drive of your computer.
	2. Follow the prompts on the screen for installation of the WiFi driver.
	Firmware Upgrades

	Future upgrades to BMP®61 firmware can be downloaded from Brady’s website.
	1. From your PC, access www.bradyid.com/BMP61.
	2. Click Technical Support>Downloads.
	3. From the list of download options, click Firmware then, from the list of products, select BMP®61.

	The firmware download is packaged in a .zip file.
	4. Click Begin Download button .
	5. Placed the downloaded .zip file in the PC directory of your choice.
	6. Open the downloaded .zip file, press [Ctrl+A] (to select all) and click Extract in the .zip file window.
	7. In the pop-up Browser, select the drive and directory where the extracted files should be placed, then click Extract .
	8. Locate the directory containing the extracted files and double click the Upgrade folder.
	9. Double click Setup.exe.
	10. From the drop down list, select your preferred language, then click .
	11. On the Welcome screen, click again.
	12. On the Installation Folder screen, the upgrade files will be placed in a default directory or you can select a different directory, then click .
	13. On the Shortcut screen, click .
	14. On the Ready to Install screen, make note of the Install folder and Shortcut folder, for future reference, then click .
	15. When the firmware download is successfully installed, click .
	16. Now locate the directory where the firmware was installed and double click BMP61 Update Utility.exe.
	17. Follow the prompts to connect the BMP61 printer to your PC, turn the printer on, then click Upgrade BMP61 .
	18. When successfully loaded, turn the printer off, then turn it on again.

	The new firmware is available for use.
	Y & B Values

	The Y & B values are parameters loaded onto the BMP61 printer to enable the printer to better work with current media and new media that might be added to the unit.
	New Y & B values are continuously being generated, so for optimum performance of your BMP61 printer and materials, you should upload the new values whenever you add enhancements, changes, or new parts to your BMP61 printer.
	Updating Y and B Values

	To upload new Y and B values:
	1. Select SETUP.
	2. Select Config.

	The currently installed version of the Y and B values can be found in the lower right corner of the screen.
	1. From your PC, access www.bradyid.com/BMP61.
	2. Click Technical Support>Downloads.
	3. From the list of download options, click All Downloads then, from the list of products, select BMP61 Database Update (Rev Y-#, B-#).
	4. Click Begin Download button .
	5. Placed the downloaded .zip file in the PC directory of your choice.
	6. Extract all the files in the .zip file and transfer the extracted files to the root directory of a flash drive.
	7. Place the flash drive into the USB port of the BMP61 printer.

	The printer detects the flash drive automatically, showing you both the version of the files on the printer, and the version of the files on the flash drive.
	8. With a checkmark next to the files you want to upgrade, select Upgrade or press Enter on the keypad.
	9. Select Yes to confirm the upgrade.

	Once the printer is updated, you can use the files on the flash drive to upgrade other BMP61 printers you may have in your possession.
	10. If you have more printers to update, select Ignore on the Delete from External Media screen.

	This retains the upgraded Y & B files on the flash drive.
	11. If this is the only printer to update, select Delete .

	This deletes the Y & B upgrade files from the flash drive ONLY (not from your printer).
	Ribbon

	Product numbers for ribbons for the BMP61 printer begin with M61. Example: M61-R4310.
	Remove Ribbon
	2. Grasp the ribbon and gently slide out of printer.

	Load Ribbon
	2. Carefully slide the ribbon cartridge into the printer until it seats firmly against the metal frame, then flip the printhead lock lever forward (to the left) to re-engage the printhead.

	Media

	Brady labels come equipped with smart-cell technology that enables the printer to recognize the type of label and automatically sets many label formatting details.
	For optimum performance, it is recommended that you use genuine Brady BMP61 labels. Labels can be loaded with the power on or off.
	Before inserting labels, be sure to remove the protective tape covering the leading end of the labels.
	Loading Media
	2. With labels coming off the top of the spool, grasp the smart cell handle and insert the labels straight into the smart cell reader compartment, gently pushing until it clicks into place.
	3. If using anything but a 2-inch width media, slide the media guide to the left until it fits snugly up against the media roll and clicks into place.
	4. Feed the leading edge of the media roll through the guide slots until it stops.
	5. With the Power on, press Feed button once to feed media under printhead.
	6. Close the cover by pushing down on it until it snaps into place.

	Unload Media
	2. Flip the printhead lock lever backward (to the right) to disengage the printhead.
	3. If label spool is not empty, gently rewind the spool with your finger to back the unused media out from under the print head.
	4. Grasp the media roll smart cell guide and gently pull up out of the tape well.
	5. If you do not want to load any more media, close the printer cover by pressing down on the cover until it catches.

	Loading Bulk Media
	2. On the bulk media box, push Tab A and C in, then pull the perforated flap down and tear off.
	3. Attach the label feed ramp to the bottom of the perforation, with the ramp arms on the outside of the box.
	4. Attach the ramp hooks to the outside of the bulk label feed path on the printer.
	5. Insert the BMP61 label spool (smart cell facing left) into the printer. Adjust the media guide as needed.
	6. Pull the loose end of the bulk media out of the box punch-out and thread over the tray and into the bulk label feed path on the printer.
	7. Continue to feed the leading edge of the media roll over the label spool and through the guide slots until it catches.
	8. Turn the printer on and press [FEED] to feed the media through the printer.
	9. Close the printer cover.

	B-593 Raised Panel Labels
	2. Keeping the label media in the box, place the box behind the printer, then feed the leading edge of the B-593 media through the external media feed path, over the label spool and through the guide slots until it stops.
	3. Turn the power on.
	4. Press Feed.
	5. Leave roll door open during printing.

	Attaching the Strap

	The strap can be attached to the back of the printer to provide a secure grip when holding the printer in your hand or hanging the printer on a hook.
	2. Still on the back of the printer, feed the strap under the loop at the top of the printer, directly into the media well. Then turn the printer over and from inside the media well, feed the strap out through the top of the loop.
	3. Pull the loose end of the strap under and through both D-rings.
	4. Separate the two D-rings so there is enough space for the strap to pass between them.
	5. Weave the loose end of the strap back over the first (lower) ring, then under and through the second (top) ring.
	6. Pull the loose end of the strap until it feels tight, then press the scratch (burr) fastener against the strap so it lays flat.
	7. Slip your hand through the strap to provide a secure grip when holding the printer.
	8. Or, use the third D-ring at the bottom of the printer to hang the printer on a pole or hooked device.
	Recycling the Label and Ribbon Cartridge

	Cartridges need to be recycled in accordance with local regulations. Before recycling, the used cartridges must be pulled apart to release the individual components. These various components must then be recycled in the correct recycling bins.
	Materials
	Dismantling the Ribbon
	1. Using your thumbnail, press the clear plastic locking tab down. While holding the tab down, insert the blade of the screwdriver above the smart cell and slide downward. The smart cell easily slides out for removal.
	2. With the yellow ribbon cover facing up, insert the blade of the screwdriver, one at a time, in through the five locking tab holes to depress the locking tabs. While depressing each tab with the screwdriver, use your thumb or finger to apply upward...
	3. Using the screwdriver, pry out the metal ribbon spring from the inside of the yellow ribbon cap.
	4. Once the spring is removed, turn the ribbon cartridge on its side and allow the ribbon and white spools to fall out.
	5. Unwind the ribbon from the spools, then gently peel the ribbon end from the weak adhesive that affixes the ribbon to the spool.

	Dismantling the Cartridge
	1. Unwind any remaining label meda from the spool, then gently peel the end of the media off of the spool to separate.
	2. Grip the media assembly just behind the black end cap (containing the smart cell).
	3. With your thumb, apply pressure to the back of the black end cap to separate the cap from the media cartridge core.
	4. From the back side of the black end cap, press the blade of the screwdriver against the locking tabs, applying outward pressure. This will release the smart cell.
	5. Slide the cardboard core off of the plastic cartridge core.

	Recycling Components

	These components should be removed from the cartridge and recycled according to the following guidelines.
	Power On
	1. Press Power .


	To preserve battery life, when the printer detects a time of inactivity, it automatically shuts down. Any data on the screen at the time of auto shutdown is retained and available the next time the [Power] key is pressed to restart the printer. (See ...
	The first time the printer is turned on, you may want to choose a language in which to display screen items. Language selection is performed in the Setup function. (For more information, see “Setup Language” on page 1-52.)
	Whenever the printer is powered on, the system performs an initialization process. Part of this process is recognizing the media installed. While it is possible to power on the printer without installing media, if you choose not to install any, the p...
	Display Screen

	The display screen enables you to view font attributes and other formatting features directly on the screen while you are entering and editing data.
	The screen displays one label, or one area on a multi-area label, at a time. For labels with multiple areas, use Print Preview (see page 5-2) to view all areas together.
	Status Information

	The header bar (top) and status bar (bottom) display permanently on the screen and contain the following information:
	Navigation and Editing
	Touch Screen


	The BMP®61 printer uses touch screen technology to manipulate menus and data. Using your finger, or a stylus, touch the desired option on the display screen.
	Touch Screen Basics

	Using your finger or a stylus, use the following techniques to navigate through or access items on the touch screen.
	Keypad

	The following descriptions are based on the QWERTY keypad. If you are using a different keypad (such as Azerty or Cyrillic), some of the keys may vary. Please refer to Appendix A for a full description of other keypad layouts.
	Menus

	Menus display at the bottom of the screen and are activated by the function keys. Use navigation keys or the Touch screen to access the different menu items. Continue to press the navigation keys to access the overflow menus or, using your finger, sc...
	1. Press the function key for the menus you want to access.

	The menu choices for that particular function display.
	2. Press the left/right navigation keys to access the main menu items.

	When you access a menu item, if a sub-menu is available, it immediately pops-up.
	1. Press the up/down navigation keys

	An accessed menu displays with a yellow bar around it.
	2. To activate the highlighted sub-menu, press Enter or touch screen.

	A menu option remains in effect until a different menu option is activated.
	1. Press the Function key for the menus you want to access.
	2. Touch the desired main menu option.
	3. If sub-menus are available, touch the desired sub-menu option.

	The various functions and menus are discussed in further detail in the Formatting section of this manual, starting on page 3-1.
	Cancel Menus
	1. Press Backspace .
	1. Tap anywhere outside the menu items.

	Dialog Boxes

	Some function keys display dialog boxes, rather than sub-menus.
	1. Press Enter on the menu item.

	A dialog box displays.
	2. Press the up/down and left/right navigation keys to move to the different fields.

	To access a menu’s dialog box using the touch screen:
	1. Touch the menu item.
	2. Touch the desired field you want to edit.
	Drop Down Field Lists

	If a field has a drop down list associated with it, a small arrow displays on the right side of the field.
	1. Press Enter to open the drop down list.
	2. Use up/down navigation keys to highlight the desired option.
	3. Press Enter to select the option.

	The item is selected and the list collapses.
	1. Tap the down arrow of the drop down list to expand the list.
	2. Tap the desired option in the list.

	The item is selected and the list collapses.
	Data Fields

	Data fields require user-supplied data. Some fields may have default data already entered. When you access a field with pre-existing data, the data highlights and you can enter new data directly over the highlighted data.
	1. Use navigation keys to navigate to the data field.
	2. Enter data using the keyboard.
	3. Use navigation keys to move off the field after entering data.
	1. Tap the desired data field.

	If the data field is active (contains data), tapping the field one time highlights the data and you can type directly over it. If the data field is not active (does not contain data), tapping one time activates the field by placing the cursor in the ...
	2. Enter the desired data in the field.
	Spinner Boxes

	A spinner box lets you toggle through a range of values in a field.
	1. Navigate to the field containing the spinner box.
	2. Press Enter .
	3. Use the up/down navigation keys to toggle through the range of values.
	4. When the desired value is reached, press Enter .

	To use a spinner box, using the touch screen:
	1. Tap the field containing the spinner box.
	2. Tap the up arrow to incrementally increase the value in the field. Tap the down arrow to decrement the field value.
	Radio Buttons and Option Boxes

	In a series of radio buttons, only one radio button option can be selected at one time. In a series of option boxes, any number of options can be selected at one time.
	1. Navigate to the desired option.
	2. Press Enter .

	The option box will display a checkmark indicating it is active. The radio button will display a dot inside the button.
	3. To deactivate an option box, navigate to the option box and press Enter.

	The checkmark is removed.
	4. To deactivate a radio button, navigate to another radio button and press Enter.
	1. Tap one time on a radio button or option box to activate it.

	The option box will display a checkmark indicating it is active. The radio button will display a dot inside the button.
	2. Tap one time to deactivate the option box (remove the checkmark).
	3. To deactivate a radio button, simply tap a different radio button.
	Accept Dialog Box Edits
	1. Navigate to at the bottom of the dialog box.
	2. Press Enter .
	1. Tap at the bottom of the dialog box.

	Cancel a Menu or Dialog Box
	1. Press Backspace .


	To cancel a menu or dialog box without accepting changes, using the touch screen:
	1. Perform a downward flick in the dialog box header.
	Setup

	The Setup function key is used to determine the default settings for the printer.
	1. Press Setup .
	Pause/Cut

	The Pause/Cut function allows you to remove a label from the printer before another label starts printing. If this feature is turned on, when printing a string of labels, cutting a label initiates the next label to print.
	The Pause/Cut menu, being first in the list of primary menus, is already selected.
	1. Select On.
	Config

	The following settings can be found under the Config menu in the Setup function.
	The Shut Off Delay sets the auto-off time-out. This refers to the number of minutes of inactivity after which the printer automatically shuts off.
	When using the AC adapter, power is constant so there is no drain on the battery. In this case, you can turn off the Shut Off Delay by choosing No Shut off (AC).
	The Brightness setting increases or decreases the brightness of the display screen.
	The Firmware version currently installed on your printer can be found in the lower left corner of the screen.
	The Clean Printer button is used in conjunction with the electronic cleaning card, which can be purchased separately. (See "Internal Components” on page 7-2 of this manual for instructions on how to clean the printer.)
	Time/Date

	The following settings can be found under the Time/Date menu in the Setup function. Set the Time/Date options upon initial start-up of the printer.
	Units

	The Units setting is used to configure label parameter measurements for the printer. The units are:
	Once configured, you do not have to indicate “inches” or “millimeters” (or their globally accepted abbreviations or marks) when entering numbers in data fields. Likewise, in any scale or range of measurement field (using spinner boxes or in a...
	Language

	Depending on the printer keyboard type you are using, the following languages can be found under the Language menu in the Setup function. (See "Keyboard Configurations” on page A-1 for information on the different keyboard types.)
	Initial Language Setup

	When turning the printer on for the first time, immediately go to the Setup function and choose the language in which you want all printer menus, functions, and data displayed.
	1. Press Setup .
	2. Select Language.
	3. Select the desired language.
	Font Settings

	Use the Font Settings to indicate if you want the font size to be measured in points or millimeters.
	Touchscreen Calibration

	Calibrate the touchscreen to the desired sensitivity (soft or hard touch).
	1. Press Setup .
	2. Select Touchscrn Calibr .
	3. Follow the instructions on the screen.

	2 Getting Started
	Creating a Text Label

	This section describes the process of creating a text label with minimal formatting, using basic editing techniques, and printing the label.
	Entering Text

	Before entering label text, be sure the media cartridge is loaded and the power is ON.
	The vertical bar on the display screen is the cursor and is the starting point for every label you create using the BMP®61 printer. Begin entering text at the position of the cursor. The cursor moves across the screen as you enter data. If you want ...
	Editing Text

	If you have entered some text in error or want to change the content or format of your label, edit the information before printing.
	Inserting Text
	1. Using navigation keys, position the cursor at the point where text should be inserted. OR Touch the screen at the point where text should be inserted.
	2. Enter the text.


	Existing data positioned to the right of the cursor moves progressively to the right to make room for the inserted text. As more data is added to a line of text, the font size automatically decreases a point at a time until the smallest font size is ...
	1. Press Enter . OR Touch the error message screen.
	2. Press [ENTER] to start another line of text.
	Deleting Text
	1. Press Backspace .

	Clear

	[CLEAR] is used to clear data from the screen or cancel a function.
	1. Press Clear .

	You are presented with two options:
	Clear Label Data removes all data on the label, but leaves the formatting in place (e.g., font size, number of areas, etc.)
	Clear All removes all data and formatting from the label.
	2. Select the desired option.

	If using Clear All, a message displays asking confirmation.
	3. Press Enter to confirm the deletion. OR Touch Yes.
	4. Press Backspace to cancel the Clear All function. OR Touch No.

	You are returned to the screen with all labels and data intact.
	Cancel Functions

	Backspace is also used to cancel functions, a menu, or dialog box. When pressing Backspace in the middle of a function, you are walked out of the function a screen at a time. You may have to press Backspace several times to completely exit the functi...
	Error Messages

	If a function does not operate under current conditions, an error or information message displays indicating the problem and/or offers situational advice. Read the message carefully and follow the instructions.
	1. Press Enter . OR Touch the error message screen.
	Default Settings

	Default settings are determined by the printer for the installed media. When the label supply and/or application label type is reloaded, it will return to these settings.
	Font AutoSize

	Autosize starts with the largest font size that fits on the label. When a line of text reaches the edge of a label it scales downward until you press [ENTER] or the minimum font size is reached. When working with autosize and multiple lines of text, ...
	Autosize is turned on for all labels and is displayed as an ‘A’ in front of the font size in the upper left corner of the Header bar.
	Printing a Label
	1. Press Print .
	2. Pull the cutter lever forward (towards you) as far as it will go.


	Printing from the BMP®61 printer occurs in the background, meaning you can continue to edit or create new labels while a label is printing.
	3 Formatting
	Formatting refers to the layout, structure, and appearance of a label. Different formatting features can be found under the Font, Label, and Area functions.
	Font

	Character/line formats are called attributes that change the appearance of the fonts, such as size, weight (bold), and angle (italics).
	There are two fonts available with the BMP61 printer, Brady Fixed Width and Brady Alpine. Both fonts give you the option of displaying a zero (0) with or without a slash through it (). You can change the font when configuring the printer. (For more i...
	Size

	Font size applies to an entire line of data at a time and is measured in point size or millimeters, as determined in the Setup function.
	1. Press Font .

	A pop-up menu displays the available font sizes for the media installed.
	2. Select Size, then select the font size desired.

	If the desired size is not displayed, you can manually enter a font size within the valid size range. This option is available under “Custom” of the Size menu.
	3. Select Custom and enter the font size.
	4. Press Enter .

	When entering a custom font size, a minimum/maximum range is presented to accommodate the label size loaded in the printer. The minimum size reflects readability and the maximum size accommodates proper fit on a label. If you enter a size smaller tha...
	5. Press Enter . OR Touch the error message screen.
	Font Attributes

	Font attributes (bold, italics, underline) can be applied to individual characters in a line of text.
	1. Position the cursor where the attribute should take affect.
	2. Press Font .
	3. Select the desired attribute, then select ON.
	4. Enter the text to be affected by the attribute.

	If applying the attribute to text as it is being typed, the attribute stays on until it is turned off, or until you move to a new area or label.
	1. Press Font .
	2. Select the attribute, then select OFF.
	1. Hold Shift while moving the cursor with the navigation keys across the characters to which the attribute will be applied.

	OR
	1. At the beginning of the character string that will display the attribute, touch and briefly hold, the screen until the cursor disappears.
	2. Drag your finger across the screen to the end of the character string that will display the attribute.

	This highlights the data.
	3. Press Font .
	4. Select the attribute, then select ON.

	All highlighted text displays the attribute.
	To remove the highlighting from the characters, press any navigation key or touch anywhere on the screen.
	To remove an attribute that was previously applied to some text:
	1. Highlight the text containing the attribute to be removed.
	2. Press Font .
	3. Select the attribute to remove, then choose OFF.

	The attribute is removed from the text.
	Expand/Condense

	Expanding and condensing data affects character width and the spacing between characters in a word. Data can be expanded or condensed according to predefined percentages.
	1. Position the cursor where Expand or Condense should take affect.
	2. Press Font .
	3. Select Exp/Cond, then select the percentage desired.

	While entering data, the expand or condense attribute stays on until it is returned to 100%, or until you move to a new area or label.
	1. Highlight the data.
	2. Press Font .
	3. Select Exp/Cond, then select the percentage desired.

	All highlighted text takes on the attribute.
	Superscript/Subscript

	Superscript places a character slightly above the line of type and subscript places a character slightly below the line of type. The super- or subscript character also displays slightly smaller than the normal line of type. Superscript and subscript ...
	1. Position the cursor in the line of text where the superscript or subscript character will display.
	2. Press Sup or Sub .
	3. Type the character to be displayed in superscript or subscript.

	Only the character typed directly after pressing the superscript or subscript key is displayed in super- or subscript.
	Multi-Characters

	To place a number of characters in Super- or Subscript at one time, first enter the text, then highlight the characters to place in Super- or Subscript.
	1. Position the cursor at the beginning of the character string that you want to display in Super- or Subscript.
	2. Hold Shift while moving the cursor with the navigation keys across the characters that will display in Super- or Subscript.

	This highlights the characters.
	1. At the beginning of the character string that will display in Super- or Subscript, touch the screen, and briefly hold, until the cursor disappears.
	2. Drag your finger across the screen to the end of the character string that will display in Super- or Subscript.

	When you lift your finger off the screen, the character string is highlighted.
	3. Press Sup or Sub .

	All the highlighted characters display in Super- or Subscript.
	4. To remove the highlighting, press any navigation key. OR Touch anywhere on the screen.
	Symbols

	The BMP61 printer contains hundreds of symbols that can be used for a variety of applications.
	1. Position the cursor at the point where you want the symbol to display.
	2. Press Symbol . OR Touch the Header or Status Bar, then touch Symbol.
	3. Select the symbol category.

	A symbols grid displays. Some of the grids are lengthy and may require scrolling to view all the symbols.
	4. Select the desired symbol.
	5. Press Enter . OR Double tap the desired symbol.

	The symbol displays with the same font size that is currently in use.
	Remove a Symbol from Label

	The symbol is the same as any other character.
	1. Postion the cursor to the right of the symbol.
	2. Press Backspace .
	Graphics

	Graphics are symbols, logos, or other artwork supplied from an outside source, such as a PC. These graphics must be bitmap files (*.bmp) and can only be black and white. The BMP61 printer will automatically resize the graphic, but it is important to ...
	Download Graphics

	Graphics are added to the BMP61 printer through the Import function. This function displays in the File menu if an external memory device is attached.
	1. Attach the external memory device containing the graphic you want to import to the BMP61 printer.
	2. Press File .
	3. Select Import>Graphics.
	4. Select the graphic to import.

	Graphic files (.bmp) are stored in a specific folder used by the Graphics function. This folder is unavailable to the user and therefore, when importing a graphic, the destination screen does not display. You can view and use imported through the Gra...
	For a more comprehensive discussion of importing files, refer to "Using Files from an External Source” on page 4-11.
	Add a Graphic
	1. Position the cursor at the point where you want the graphic to display.
	2. Press Graphics . OR Touch the Header or Status Bar, then touch Graphics.


	The graphics grid displays, with the most recently used graphic displaying first.
	3. Select the desired graphic.
	4. Press Enter . OR Double tap the desired graphic.

	The graphic displays with the same font size that is currently in use.
	International Character Sets

	The BMP61 printer contains hundreds of internationally recognized characters, complete with diacritical marks.
	To add an international character to your label:
	1. Position the cursor at the point where you want the international character to display.
	2. Press the International key .

	A list of international characters displays.
	3. Scroll through the list until the desired character is found.
	4. Press Enter . OR Double tap the desired character.

	The character displays with the same font size that is currently in use.
	Date and Time
	1. Position the cursor at the point on the label where you want the date and/or time to be inserted.
	2. To insert the date, press Insert Date . OR Touch the Header or Status bar, then touch Date in the pop-up menu.
	3. To insert the time, press Insert Time . OR Touch the Header or Status bar, then touch Time in the pop-up menu.


	The BMP®61 printer inserts the current Date or Time data using the current system clock value at the time of printing and the date/time format defined in the Setup function. (For more information, see "Time/Date” on page 1-45.)
	The date or time displays the selected format on the editing screen (e.g., mm/dd/yy or HH:MM). To view the actual date or time, use Print Preview (see "Print Preview” on page 5-2).
	Labels and Areas

	You can create a number of labels in one label file, each new label being inserted immediately after the current label.
	Areas are used to apply different formatting (such as justification, rotation, and frames) to different parts of a single label. Areas can only be added to continuous media set to auto length mode. However, area formatting can be applied to die cut l...
	Add Label or Area
	1. Press Label . OR, to add an area to a single label: Press Area .
	2. Choose Add.


	The new label is inserted immediately after the current label and its number is reflected on the right side of the Header bar. Each label added will be of the same application and label type.
	A new area is inserted immediately after the current area and is reflected on the right side of the Header bar. The font size used on the first line of the previous area carries over to the new area.
	Label Length

	Auto length is the default for continuous media. With Auto Length, the label will be as long as it needs to be to accommodate the entered data, up to a maximum of 40 inches. You can, however, set a fixed length for a label. A different length can be ...
	1. Press .
	2. Select Length>Fixed.
	3. In the text entry box displayed, enter the desired length of the label.
	4. Press Enter .
	Go To Label or Area
	1. Press Label .


	OR
	1. Press Area .
	2. Select GoTo, then enter the number of the label or area to go to.
	3. Press Enter .
	Shortcut Using Keys
	1. Press Next Label .
	1. Press Previous Label .
	1. Press Next Area .
	1. Press Previous Area .

	Shortcut Using Touch Screen

	You can access different labels in a multi-label file or different areas on a multi- area label using the scroll arrows on the screen.
	1. Touch Labels in the Header bar.

	Four arrows display on the screen.
	2. Touch the Down arrow to access the next label in the sequence.
	3. Touch the Up arrow to access the previous label in the sequence.
	4. Touch the Right arrow to access the next area in the sequence.
	5. Touch the Left arrow to access the previous area in the sequence.

	If you do not have multiple areas on a label, or multiple labels in a file, the arrows are grayed out. The arrows also gray out if you are on the first or last area or label.
	Delete Label or Area

	Deleting a label removes all data and formatting on that particular label. If multiple areas exist on one label, when that label is deleted all the areas associated with that one label are also deleted. Deleting an area removes all data and formattin...
	1. Navigate to the label or area you want to delete.
	2. Press Label if deleting a label OR press Area if deleting an area.
	3. Choose Delete.

	A Delete Label or Delete Area confirmation message displays.
	1. Press Enter to confirm deletion.
	2. Press Backspace to cancel the delete function.
	1. Touch to confirm deletion.
	2. Touch to cancel the delete function.
	Justification

	Justification refers to the alignment of data between boundaries (margins) on a label or in an area. There are two types of justification: horizontal and vertical. Horizontal justification (H. Justify) aligns data between the left and right boundarie...
	1. Navigate to the label or area where justification is to be applied.
	2. To apply justification to a label, press Label . OR To apply justification to an area, press Area .
	3. Choose H. Justify or V. Justify.
	4. Choose the horizontal or vertical justification desired.

	Every line of data on the label or in an area is justified according to the option selected. When adding a new label, the justification maintains the current justification settings, but you can change it again. Different justification can be applied ...
	Rotate

	Rotation flips the data on a label or in an area, counter-clockwise, at 90° increments. Rotation affects all data on a label or in an area.
	Data cannot be rotated on a line-by-line basis. When adding a new area or label, the rotation is the same as the previous area or label.
	1. Navigate to the label or area where rotation will take affect.
	2. To set rotation for the label, press Label . OR To set rotation for an area, press Area .
	3. Choose Rotate>degree of rotation.

	Rotated data is autosized to accommodate the height vs. the width of the label.
	Rotation does not display on the editing screen, although the degree of rotation is displayed in the upper left corner of the screen. To view the actual rotation, use Print Preview. (See "Print Preview” on page 5-2).
	Frame

	A frame (border) can be added to an area or a label, but not to a line of text. You can have a different frame, or no frame, on individual labels in a multi-label file. You can also place a frame on a label that contains area frames.
	1. To add a frame to a label, press Label . OR To add a frame to an area, press Area .
	2. Choose Frame>frame type.

	Frames do not display on the editing screen. Use Print Preview (see page 5-2) to view the label or area frames.
	1. Navigate to the label or area that contains the Frame.
	2. Press Label . OR Press Area .
	3. Choose Frame>None.
	Reverse

	The Reverse function switches the foreground and background colors of data on a label, based on the color ribbon and media installed.
	For instance, black lettering on a yellow background, if reversed, would print yellow lettering on a black background.
	You can apply Reverse formatting to areas or labels. When adding another area or label, the reverse function status carries over. Reverse cannot be applied to an individual line of text or to a barcode.
	1. Press Label . OR Press Area .
	2. Choose Reverse>ON.

	The system formats the edge-to-edge data so that the foreground and background colors are switched.
	1. Navigate to the label or area displayed in Reverse.
	2. Press Label . OR Press Area .
	3. Choose Reverse>OFF.
	Vertical Text

	In Vertical text, each character drops down a line below the preceding character.
	W I R E
	Vertical text can only be applied to an area or a label. It cannot be applied line-by- line.
	1. Navigate to the label or area where you want to display text vertically.
	2. Press Label . OR Press Area .
	3. Choose Vertical>On.

	The word(s) display vertically on the label or in the area.
	If more than one line of text is present, the second and subsequent lines of text display vertically to the right of the first line of text.
	If a barcode is in the line of text to be placed vertically, or if the height of the label cannot accommodate the vertical placement of text, an error message displays.
	The Editor then displays the text in its original format, without applying the vertical text option.
	1. Navigate to the label or area displaying data as Vertical Text.
	2. Press Label . OR Press Area .
	3. Choose Vertical>OFF.

	The text realigns according to predefined formats.
	Barcode

	A Barcode element represents a barcode graphic generated from user input. Barcodes are generated following industry standard symbology. A typical barcode is composed of vertical lines (bars) and spaces of varying thickness, depending on the text ente...
	Barcode elements support vertical resizing (height) only. The width of the barcode is based on data and symbology and cannot be changed. However, some barcode widths (depending on symbology used) can be altered by changing the ratio and density of th...
	Barcode data can be displayed in the same line as other data (text or symbols). It is not necessary to have a separate area for the barcode. Barcode data on the same line as text will not overwrite the text already on the line but will be placed next...
	Barcode Settings

	Before entering a barcode, determine the barcode symbology and attributes to use.
	1. Press Label .
	2. Select Barcode.
	3. Select the desired settings. (For information on how to work with dialog box fields and features, refer to Dialog Boxes, starting on page 1-37.)
	4. When finished, select .
	Add a Barcode

	The barcode key acts as a toggle between a barcode and text. Press once to turn it on, press again to turn it off.
	1. Position the cursor where you want to add the barcode.
	2. Press Barcode .
	3. Enter the barcode data.

	The barcode displays on the screen as the data is being entered.
	When finished with the barcode entry, if you want to enter more data on the same line of text as the barcode:
	1. Press Barcode again.

	This turns the Barcode mode off and returns to text mode.
	OR
	When finished with the barcode entry, if you want to start a new line of text BELOW the barcode entry:
	2. Press Enter .

	Pressing Enter moves the cursor to the next line, automatically turning off the Barcode function.
	Edit Barcode Data
	1. Position the cursor in the barcode text.


	The barcode mode automatically turns on.
	2. Edit the barcode text.

	The barcode mode automatically turns off when you move past the last character of the barcode.
	Serialization

	Serialization (or sequencing) automatically adds a series of sequential numbers or letters to the printed labels. The Serial function consecutively places the next number or letter in the defined sequence on individual labels. The number of labels cr...
	Serialization can be combined with other data on a label. Any data displayed on a label that includes serialization will be repeated on every label along with the serial data.
	How Serialization Works

	Serialization is alphanumeric, with numbers from 0 to 9, and letters A-Z. Serialization can be simple or linked, with a maximum of two sequences per label.
	Serialization consists of a Start Value, End Value, and Increment. The Start Value is the number, letter, or combination of numbers and letters that begin the serialization sequence. The End Value is the termination point of the sequence.
	The Increment is the value that is added to the previous number in the sequence to produce the next sequence number. (You cannot have an increment value of 0.) For instance, a start value of 1, an end value of 25, and an increment of 4 would produce ...
	Examples of Serialization

	In a simple serialization, a sequence runs through its full range of numbers and/or letters (i.e., 0 to 9, or A to Z), one number/letter for each label.
	You can combine letters and numbers in a single serialization. When the right- most character in the Start Value reaches its maximum value (9, Z), the character immediately to the left is incremented, and the right character cycles back to its mimimu...
	In a multi-sequence serialization, where the second set of values is NOT dependent on the first set (i.e., Linked box NOT checked), the two sequences increment sequentially, independent of each other.
	In a multi-sequence “linked” serialization (i.e., Linked box checked), the second set of values is dependent on the first set. The second sequence holds its initial value until the first sequece completes, after which it moves to the next value.
	Add Serialization
	1. Position the cursor on the label where you want the serialization to display.
	2. Press Serial .


	A dialog box displays where you can enter the start value of the serialization, the end value, and the increment value.
	3. With the cursor immediately displayed in the Start Value field of Sequence #1, enter the start value of the sequence.

	If the start value is larger than the end value, the series will decrement automatically.
	4. In the End Value field, enter the end value of the sequence.
	5. In the Increment field, enter the increment value.
	6. When ready, select .
	7. Complete Steps 1 through 6 above.
	8. On the Editing screen, navigate to the next sequence location (cursor position) on the label. (Skip this step if creating a compound serialization displaying at the same cursor position.)
	9. Press Serial .

	The previous serialization values display in the dialog box presented.
	10. Navigate to the Add Seq 2 option box and press Enter .
	11. In the Sequence #2 Start Value field, enter the start value for that sequence.
	12. In the Sequence #2 End Value field, enter the end value for that sequence.
	13. In the Sequence #2 Increment field, enter the increment for that sequence.
	14. Navigate to the Linked option box.
	15. Press Enter .
	16. Navigate to the OK button and press Enter .

	The total number of labels to be printed in the sequence displays in the Header Bar (i.e., Label # of ##).
	Edit a Sequence

	You can change the serialization values after a sequence has been determined.
	1. Press Serial .

	The Serial dialog box displays with the current values listed.
	2. Select the value fields to change and enter the new value.
	3. When ready, select .
	List

	The List function enables you to produce multiple labels with variable information from a single, formatted label (main document) and a structured data source.
	The data source (or database) is a collection of organized, related data. It is often set up in the form of a table, containing fields (columns) and records (rows). A field is one category of information for each record, while the record is the combi...
	When the merge is run, the system creates an output label for each record (row) in the data source.
	Setting up the Data Source

	The data source must be a .csv file created in a spreadsheet or database program on a PC and imported to the BMP61 printer via the USB port and a flash drive. You can also create the .csv file directly on the BMP61 printer. If you have created the .c...
	1. Press List .
	2. Select Create.
	3. Enter the number of fields (columns) the data source will contain.
	4. Select Continue .

	The number of defined fields displays as blue and yellow squares at the top of the screen. The blue field is the current field. The gray square displays the record number as data is entered into the data source.
	5. Navigate to the field where you want to enter data and press Enter .

	The data entry area of the selected field displays on the bottom half of the screen.
	6. Enter the data for that particular field category, then press Enter .
	7. Repeat Steps 5 and 6 for each field in which you want to enter data.

	When you entered data in each defined field, another row automatically displays.
	8. Select Next to move to the first field in the next row, then press Enter to access that field.
	9. Repeat the above steps for each record of the data source.
	Working with Rows of Data
	1. Select Next to move foward through the rows of data.
	2. Select Prev to move backward throught the rows of data.
	1. Select a field in the row above which a row will be inserted. It makes no difference which field you select.
	2. Select Insert .


	The row selected moves down and a new, blank row is inserted.
	1. Select a field in the row you want to delete.
	2. Select Delete .
	Save the Data Source
	1. Select Save .
	2. Enter a name for the data source, then press Enter .
	3. Press Backspace .


	A message displays asking if you want to save the file before exiting.
	4. If you have already saved the file, select . The file remains saved.
	5. If you have not yet saved the file, select . The printer will return to the Save function. Repeat Steps 2 through 4 to save the file.
	6. Select if you do not want to exit the database.
	Merging Files

	Fields from the data source merge into specific areas defined on the label.
	1. Create, or open, the label that will receive the data from the data source.

	With the label in the Editing screen:
	2. Press List .
	3. Select Merge.
	4. Select Internal or External to indicate where the data source file is stored.
	5. Select the data source file.

	If your label does not have the same number of defined areas as there are fields in the data source, the List function asks if you want to add additional areas.
	6. Select Ignore if you do not want to add additional areas.

	The fields from the data source sequentially merge into the label, depending on how many areas are defined on the label. If you have four fields in the data source but only two areas defined on the label, the first two fields merge on to the label. T...
	OR
	7. Select Add if you want the printer to define as many areas on the label as there are fields in the data source. Once the merge is complete, you can go back into the label and format the added areas.

	The unique data in the data source file is merged to the label. Each field displays in a different area of one label. Each record (the collection of the fields) displays on a different label.
	Advanced Merge

	You can create a data source to have many fields with varying information. However, you do not have to use every field on every label. For instance, even though the example database contains four fields (name, address, city-state, and customer number...
	1. With the label open, press List .
	2. Select Adv Merge.
	3. Select Internal or External to indicate where the data source file is stored.
	4. Select the data source file.

	The screen indicates how many fields are in on the particular label. It also lists how many fields are available in the data source. You can change which field in the data source you want to display in the areas of your label.
	5. Select the Area field and enter the data source column number to use.
	6. Select .
	Edit Datasource

	You do not have to enter all records into the data source at one time. You can continue to add more records to a saved data source as needed.
	1. Press List .
	2. Select Edit.
	3. Select Internal or External to indicate where the data source file is stored.
	4. Select the data source file .
	5. Enter field and record information as indicated on page 3-37.
	1. Select the field to edit, then make the corrections according to normal editing procedures. (See "Editing Text” on page 2-1. )
	2. When finished, save the data.

	4 File Management
	Label Files

	A single label or a number of labels can be saved as a file, to be opened and reused at a later date. The following are guidelines when creating a label file:
	Save

	A saved file is held internally in the printer, even when the power is turned off. The saved file retains the label data, data attributes, and alignment parameters. This file is available for reuse whenever needed.
	File Naming Standards

	To create a file on the BMP61 printer, the file must be given a name. Names can be up to 20 characters long and can consist of letters and numbers, no spaces.
	When creating files, remember this rule: You cannot have two files with the same name. If you do, the most recent file with the name will overwrite the previous file with that name. A one-character difference in the name creates a different file and ...
	Internal vs. External

	You can save labels as internal or external files. Internal files are labels stored directly on the BMP61 printer. External files are labels stored on some external device, such as a flash drive.
	1. Press File .
	2. Select Save.

	The memory location dialog box displays ONLY if an external source is attached to the printer.
	3. Select Internal to save directly to the printer. OR Select External to save to the attached external source.

	<New Folder> displays in the text entry box. You can enter the file name directly over the <New Folder> moniker.
	4. In the displayed text entry box, enter a name for the file.
	5. Press Enter .

	If the name already exists, a message displays asking if you want to overwrite the previous file with that name.
	1. Press Enter to overwrite.

	OR
	2. Press Backspace to remove the message from the screen and return to the file name entry field.
	1. Touch to overwrite.
	2. Touch to cancel the overwrite and return to the file name entry field.

	When the file is saved, you are returned to the Editing screen with the saved file still displayed. If you want to remove the saved file from the screen, press Clear . (See "Clear” on page 2-3 for more information.)
	Folders

	To better organize your data, place similar label files into folders. Similar files could consist of all labels for a specific project, or all files that use the same media, or specific label applications, etc.
	1. Press File .
	2. Select Save.
	3. With the <New Folder> moniker highlighted in the text entry box, press Enter . OR Double Tap <New Folder>.
	4. Enter a name for the folder.
	5. Select .
	1. Press Enter . OR Double Tap <Previous Folder>.
	Open a File
	1. Press File .
	2. Choose Open.


	A list of previously saved folders and files displays.
	3. Navigate to the folder to open.
	4. Press Enter .
	5. Within the folder, navigate to the file to open, then press Enter .
	6. Double Tap the folder.
	7. Within the folder, Double Tap the file to open.

	Only one file can be displayed on the screen at a time. When opening a saved file, if the Editing screen contains other data, you are prompted to save the data before the screen is cleared.
	If you decide to save the displayed data, the Save function is invoked and you are allowed to give the data a file name before the requested file to open is displayed in the Editor.
	When opening a file, if the stored data is incompatible with the installed media, an error message displays.
	While you do not have to use the exact label part number used when saving the file, you must use a part number that can accommodate the data in the file being opened.
	Delete a File

	The Editor does not have to be cleared before deleting a file. A file can be deleted with other data still on the screen.
	1. Press File .
	2. Select Delete.
	3. Select the type of file you want to delete (graphics, list, or label).

	A list of previously saved folders and files displays.
	4. Select the folder containing the file to delete (if applicable).
	5. Select the file to delete.

	A delete confirmation message displays.
	6. Select to confirm deletion. OR Select to cancel the delete function.

	If Yes is selected, the file is removed from the system and is no longer available for use.
	Using Files from an External Source

	You can use labels, .csv lists, or .bmp graphics created on a PC and stored on a flash drive. Labels can be imported (transferred) from a flash drive to reside on the BMP61 printer or you can open the label file directly from the flash drive. (Refer ...
	Import a File
	1. Attach the external device to the BMP61 printer.


	The Import menus will only display if the external device is attached.
	2. Press File .
	3. Select Import.
	4. Select the file type you want to import (Label, List, or Graphics).
	5. Using Folder and File navigation techniques (refer to opening a folder, starting on page 4-7), select the file you want to import from the external device.
	6. If importing a Label file, on the Select Destination screen, select the destination folder or storage area on the BMP61 printer where you want to store the imported file.

	Label files can be stored in any folder on the printer. However, List files (.csv) and Graphic files (.bmp) are stored in specific folders used by the List and Graphics functions. These folders are unavailable to the user. When importing a list or a ...
	7. Press Enter to place the imported file in the selected folder.

	Imported files retain the original file name the first time they are imported. If imported more than once, " - Copy [#]" is attached to the file name (where # is a number indicating how many times the file has been imported). This prevents a file fro...
	You can open an imported Label file through the File/Open function (see page 4-7)
	List (.csv) files can be opened through the Merge feature of the List function.
	Graphics (.bmp) files can be viewed and accessed through the Graphics function.
	Export a File

	Files created on the BMP61 printer, or previously imported from an external device can, in turn, be exported back to an external device.
	1. First, attach the external device to the BMP61 printer (to ensure the Import/Export menus display).
	2. Press File .
	3. Select Export.
	4. Select the file type you want to export (Label, List, or Graphic).
	5. Using Folder and File navigation techniques, select the file you want to export to the external device.
	6. On the Select Destination screen, using folder navigation techniques, select the destination folder or storage area where you want to store the exported file on the external device.
	7. Enter the name for the file to export, then press Enter to export the file.

	5 Printing Labels
	Print

	The Print function prints the current file.
	1. Press Print .

	The data is printed and the status of the print job is reflected in the Status Bar (e.g., Printing 1 of 10).
	2. Pull the cutter lever forward (towards you) as far as it will go.

	Printing from the BMP61 printer occurs in the background, meaning you can continue to edit or create new labels while the file is printing.
	If a print job is interrupted, for instance when media or ribbon runs out, or you intentionally open the cover, the system automatically stops the print job and displays a message. While the message remains on the screen, follow the instructions on t...
	Print Preview

	The Print Preview function of the BMP61 printer enables you to view your label file prior to printing.
	1. Press Preview . OR Double Tap the data in the Editor screen.

	The label contents display.
	2. Press Print .
	1. Press Backspace . OR Tap the print preview screen.

	You are returned to the editing screen.
	Scrolling in Print Preview

	If a label file is particularly long it may not be completely visible on one screen in print preview. The Print Preview screen displays left/right or up/down scroll bars indicating there is more data to view.
	1. Press up/down navigation keys, as applicable. OR On the touch screen, drag your finger in the direction you want to move.
	Multiple Print

	Multiple print lets you print multiple copies of a label or series of labels.
	1. Press Multi .
	2. With the cursor in the No. of Copies field, enter the number of copies desired.
	Collate

	To get multiple copies of a serialization, first determine if the sequence should be collated or non-collated.
	Collated – All sequential numbers will print once, then the entire sequence prints again.
	Non-collated – Prints all first numbers in a sequence, then all second numbers, etc.
	The default is to print collated. If you do not want to collate the copies:
	3. Select the Collate option box to remove the checkmark.

	When printing (or re-printing) a single label in a series, or a range of labels in a series, use the Print Range feature.
	4. Under Print Range, select From field and enter the number of the first label to be printed.
	5. Select To field and enter the number of the last label to be printed..
	Separator

	To separate different labels on continuous media, add a separator.
	6. Select the desired separator from the drop down list.
	Mirrored Print

	Mirrored print takes all data on a label and flips it to provide a mirror image. Mirroring displays on the printed label only.
	Mirrored print is label-based, meaning all data on the label is mirrored. You cannot mirror data in an individual area.
	7. In Multiple Print dialog box, select Mirrored Print to place a checkmark in the option box.
	8. When finished with all options, select .
	Print History

	Print History is a convenient feature that enables easy access to recently used files. It keeps track of the last 10 label files printed.
	1. Press Print History . OR Touch the Header or Status bar, then select Print History.

	A list of previously printed files displays at the bottom of the print screen. You can reprint any of these files.
	2. Select the file you want to print.
	3. Press Print .

	If the file you want to reprint is incompatible with the currently installed media, a message displays indicating such.
	4. To correct, install the media indicated in the error message.
	5. Clear the message, then press Print .

	6 Label Types
	Label Types

	Label types provide templates that guide and control the layout for label formats and may require specific media. The label types available are:
	General

	The General label type contains standard functions and formats used for most generic labels. However, all other label types provide templates that guide and control the layout for the specific application.
	Depending on the application chosen, a sub-menu or dialog box displays to collect information for automatically formatting the specific label type.
	The name of the specific label type being used is displayed in the Header bar below the media indicator.
	WireMarker

	The WireMarker label type is designed to repeat entered data down the length of the label. The data repeats as many times as possible, considering the font size and the wire size selected.
	Die-cut, self-laminating, or continuous media can be used for WireMarker labels.
	1. Press Label Type .
	2. Select WireMarker.
	3. Select the wiremarker gauge and length.
	4. Enter the data.

	The data is repeated down the wiremarker label as many times as the length of the label allows and the font size used. The smaller the font size, the more the data is repeated.
	If you press [Enter] to start a new line of text, a space opens below each line of repeated data and begins to repeat the next line of text as you enter it.
	Flags

	A Flag label wraps around a wire or cable, with the ends joined together to form a flag. The Flag application is designed to work with continuous media or specific multi-area die cut labels.
	1. Press Label Type .
	2. Select Flags.

	A dialog box displays the different Flag layouts, preceded by a radio button. (For a review of dialog box navigation, see "Dialog Boxes” on page 1-37.)
	1. Select the radio button of the desired layout.
	2. If continuous media is installed, in the Flag Length field, enter the length of the flag (the part that contains the text).
	3. In the Cable Diameter field, enter the diameter of the wire/cable to which the flag will be applied.

	The range for the cable diameter is 0.25 inches to 8 inches. By entering the diameter of the wire or cable, the system automatically calculates an additional length of label to allow complete wrap of the wire/cable with additional label material left...
	If Rotate is selected, each element of the text layout in the selected template (Text 1, Text 2) rotates 90 degrees left or right from it original position.
	4. To rotate data, select Rotate to place a checkmark in the option box.
	5. When finished, select .
	6. On the Editing screen, enter the text that will display on the flag.

	Rotation is embedded in the template design, based on the flag design you pick. Justification is defaulted to center, middle. The font size remains whatever size is set when the flag label type is chosen.
	If the design chosen indicates only one text element, the printer automatically duplicates the entered text for the other area, rotating according to the predefined layout.
	In a 2-text element flag layout, you enter text in two separate areas. The areas are designated in the Header bar. Use the Next Area and Prev Area keys to move to the different areas. The Header bar indicates which area you are in. (See "Labels and A...
	Use Preview to view the labels before printing.
	Terminal Block, 66 Block, Patch Panel

	Terminal Block, 66-Block, and Patch Panel applications are designed to be used with continuous media. If no continuous media is installed, these applications do not display in the menu.
	1. Press Label Type .
	2. Select Terminal Block, 66 Block, or Patch Panel.

	A dialog box displays requesting additional information. (For a review of dialog box navigation, see "Dialog Boxes” on page 1-37.)
	3. In the Terminal Repeat field, indicate the size of the gap between each terminal (with a minimum of 0.2 inches).
	4. In the Number of Terminals field, enter the number of terminals on the block for which the label is intended.

	If you intend to use serialization for the Terminal Block, 66-Block, or Patch Panel label type, you do not need to enter the Number of Terminals. The serialization values determine how many labels to create.
	5. To serialize data, select Serialize to place a checkmark in the option box.

	Once Serialize is selected, the Number of Terminals field grays out, making it inaccessible to enter data.
	6. In the Separator field, from the drop down list, select the separator to use.
	7. In the Orientation field, from the drop down list, select the desired layout.
	8. When finished, select .

	If the Serialize option box is checked, the Serial dialog box displays.
	9. Complete the Serialization. (See "Add Serialization” on page 3-33 for more information.)
	10. When finished, select .

	The number of terminal blocks are created as labels, with the serialization characters displayed on each label.
	If serialization was not used, on the Editing screen, enter unique data for each label.
	Use Preview to view the labels before printing.
	110-Block, Bix Block Label Type

	The 110-Block and Bix Block use only the following dedicated label parts.
	The 110-Block label type is based on user-selected pair configurations, with the length of the label determined by the pair type selected. The label height uses a dedicated 110-Block part height of 0.475 inch. The length of a 110-Block label is 7.5 i...
	Bix Block template information is similar to the 110-block, with some variations on height and length of strip. The label height uses a dedicated Bix Block part height of 0.625 inch. The length of a Bix Block label is 6.2 inches with a total strip le...
	1. Press Label Type .
	2. Select 110-Block or BIX Block.

	A dialog box displays requesting further information. (For a review of dialog box navigation, see page 1-37.)
	In the 110- and Bix Block applications, the number of areas created is based on the pair configuration selected. Vertical and horizontal separator lines are automatically added.
	The following example displays the areas based on the Block Type selected (i.e., 2-pair, 3-pair, 4-pair, 5-pair, or blank). The “Blank” strip is formatted as two areas covering the full printable length of the strip.
	3. In the Block Type field, from the drop down list, select the pair configuration to use.

	Sequence Type is used to determine how, and if, you want to serialize data. If None is selected, the areas are blank and you can independently enter data in each area of the strip. Horizontal increments one number per area, based on the start value.
	In Backbone serialization, the left-most area on each strip prints with two numbers. The first number is left-justified; the second number is right justified. All other areas print with one right-justified number.
	4. In the Sequence Type field, from the drop down list, select the Sequence Type to use.
	5. In the Start Value field (except when “None” is selected in the Sequence Type field), enter the first number of the sequence.
	6. In the # of Strips field, enter the number of strips (labels) to be created in the block configuration chosen.
	7. When finished, select .
	Vial

	The Vial label type can be used with any media except SelfLam or Permasleeve. (If SelfLam or Permasleeve media is installed, the Vial label type does not display.) The Vial label type fixes the length of the label based on the vial size selected and ...
	1. Press Label Type .
	2. Select Vial, then select the vial size.
	3. Enter the data to display on the vial label.
	1. .
	DesiStrip

	A DesiStrip (Designation Strip) is a paper faceplate label that can rest over the keys of a phone or switches in a breaker box, etc.
	1. Press Label Type .
	2. Select DesiStrip.
	3. In the Length field, enter the length of an individual strip.
	4. Select .
	Breaker Box

	Breakers are usually arranged in two columns or along one row, depending on geographic regions. The breaker positions are numbered left-to-right or top-to- bottom, depending on label orientation. This numbering system is universal across various comp...
	1. Press Label Type .
	2. Select Breaker Box.

	A dialog box displays. (For a review of dialog box navigation, see "Dialog Boxes” on page 1-37.)
	3. In the Breaker Repeat: field, enter the width of a standard breaker.
	4. In the Number of Breakers: field, enter the number of breakers to be labeled.

	This produces one continuous strip, separated by the Breaker Repeat width, vertically aligned for US breaker boxes, or horizontally aligned for EU breaker boxes.
	The BMP61 firmware also includes the pole count to calculate the distance between breakers to ensure accurate spacing. A single-pole breaker takes up only one space in the electrical panel, while a double-pole takes up two.
	5. If the breakers contain different pole counts, select Variable Pole Count to place a checkmark in the option box.
	6. In the Separator field, from the drop down list, select the separator to use.
	7. In the Orientation field, from the drop down list, select the orientation to use.
	8. When finished, select .

	If Variable Pole Count is selected, the Breaker Box Pole count dialog displays. The number of poles for each breaker defaults to 1.
	9. Select the Breaker number field to change and enter the appropriate number.
	10. When finished, select .
	11. On the Editing screen, enter the unique data that will display on the label for each breaker.

	Each breaker is consigned to a single label, the number of labels designated by the number of breakers defined. The number of labels display in the Header bar. Use the Next Label and Prev Label keys to move to the different labels. The Header bar ind...
	Use Preview to view the labels before printing.
	7 Maintenance and Troubleshooting
	Cleaning the Printer

	Cleaning the printer will improve print quality and legibility. It also increases output, machine life, printer reliability and performance.
	Display Screen
	1. Lightly moisten a soft (non-scratching) cloth with isopropyl alcohol. OR Use pre-moistened static-free cloths available with the Brady PCK-6 Cleaning Kit.
	2. Gently wipe the display screen until clean.

	Internal Components

	Use a Brady BMP61 disposable cleaning card (purchased separately) to safely and effectively remove all dirt, ribbon ink residue, adhesive, and other contaminants from the thermal print head, platen roller, and paper path.
	1. From the Setup menu, select Config.
	2. Select Clean Printer.
	3. Follow the instructions on the screen.
	4. With the ribbon removed, close the printhead lock lever.
	5. Set the printer media guide to the widest position.
	6. Insert the cleaning card into the label path until it stops against the printhead and platen roller.
	7. Press Enter to initiate the cleaning routine.
	8. After cleaning is complete, remove printer cleaning card and dispose of properly.
	Replacing the Cutter Blade Cover

	If the printer is accidently dropped, the cutter blade cover may come lose or fall out. If the blade cover is not dented or damaged in some other way, you can easily re-insert the blade cover into the printer.
	1. Grasp the blade cover from the top with the cut-out portion of the blade facing the display screen (away from the media well).
	2. Pull the black flap forward, then insert the blade tight up against the black flap with the metal tabs fitting over the outside of the cutter housing.

	The blade cover snaps in easily.
	1. From inside the media well, slip your finger under the right side of the blade cover and gently pull up to unhook the blade cover.

	The blade cover releases easily.
	Replacing the Printer (Media Well) Cover

	If the printer is accidently dropped, the media well cover may come off. If the cover is not damaged, it can easily be re-attached to the printer.
	1. Insert the cover locking tab on one side of the printer cover with its corresponding locking groove on the printer.
	2. Gently squeeze the other side of the media cover enough so its locking tab can slip into the other locking groove of the printer.
	3. Push down to snap the cover into place.
	1. Press Power button to turn the printer off.
	2. Remove the AC adapter (if using one).
	3. Remove the battery pack, then immediately re-insert.
	4. Power ON the printer.
	1. Reinstall ribbon and label/media.
	2. Press [CLEAR/ESC] key to clear error.
	1. Press [CLEAR/ESC] key to continue editing.
	2. Ensure ribbon is installed correctly before printing. (See page 1-14 for proper installation.)
	1. Replace ribbon cartridge.
	2. Press [CLEAR/ESC] key to clear error
	1. With the ribbon installed, tension the ribbon by rotating the rewind spool (top spool) in a downward direction until all slack is removed.
	2. Press [CLEAR/ESC] key to clear error
	1. Replace ribbon cartridge.
	2. Press [CLEAR/ESC] key to clear error
	1. Clear any jams by opening the printer cover and removing an excess labels in the feed roller or exit chute areas.
	2. Press [CLEAR/ESC] key to clear error
	1. Replace ribbon cartridge
	2. Press [CLEAR/ESC] key to clear error.
	1. Replace ribbon or label/media.
	2. Press [CLEAR/ESC] key to clear error.
	1. Replace ribbon or label/media.
	2. Press [CLEAR/ESC] key to clear error.
	1. Replace label/media roll.
	2. Press [CLEAR/ESC] key to clear error
	1. Reinstall labels/media.
	2. Press [CLEAR/ESC] key to clear error.
	1. Clean sensors in lower printer base. Press [CLEAR/ESC] key to clear error.
	1. Replace label/media or label/media roll holder.
	2. Press [CLEAR/ESC] key to clear error.
	1. Reinstall labels/media.
	2. Press [CLEAR/ESC] key to clear error.
	1. Replace label/media roll.
	2. Press [CLEAR/ESC] key to clear error
	1. Clear any jams by opening the printer cover and removing any excess labels in the feed roller or exit chute areas.
	2. Press [CLEAR/ESC] key to clear error.
	1. Clean sensors in lower printer base.
	2. Press [CLEAR/ESC] key to clear error.
	1. Replace ribbon or label/media.
	2. Press [CLEAR/ESC] key to clear error.
	1. Press Setup.
	2. Choose Apps.
	3. Navigate to the desired applications and press [OK] to place a checkmark in front of each application.
	4. Navigate to the OK button and press [OK].


	A Keyboard Configurations
	Languages on Keyboards

	Your keyboard configuration depends on the region where you do business. The following are the currently supported keyboard configurations.
	There are four keypad configurations available for the BMP®61 Label Printer. The keypad layouts and the language supported by each are as follows:
	QWERTY
	QWERTZ
	AZERTY
	CYRILLIC

	1 Symbols
	Arrows
	DataComm
	Electrical
	Exit
	Fire
	First Aid
	CLP/GHS
	Home Electrical
	Greek
	HSID
	International
	Laboratory
	Laboratory (cont.)
	Mandatory
	Misc
	Packaging
	PPE
	Prohibition
	Public Info
	Safety
	Warning
	WHMIS


